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Introduction
   
Introduction
Welcome to the Proteus X /Emulator X Advanced Applications Guide!

The Emulator X and Proteus X are audio toolboxes with incredible sonic capabilities. 
These amazing tools allow you to sample ANY sound and then easily manipulate it to 
create a custom musical instrument.

The Emulator X and Proteus X, like all musical instruments, have a learning curve. 
However, this guide was designed to make the learning curve as easy and painless as 
possible. Once you get over the hump, you’ll be able to create your own custom instru-
ments and banks with ease.

Once you feel comfortable with the basics in chapters 1-3, feel free to browse though the 
remaining 40 lessons. The lessons are numbered in order of increasing complexity. Some 
lessons actually expand the boundaries of normal synthesis, and may provide you with 
some new ideas that you can incorporate into your music. 

Each lesson contains many useful shortcuts and tricks that you might not otherwise 
discover, and if you make it through all the lessons you’ll be a certified sampling master! 
There are a few oddball applications, which we included to demonstrate how new features 
can be invented using the power of your imagination.

Oftentimes a new sound or effect serves to stimulate the imagination and the idea for a 
new song is born. With Proteus X and Emulator X you can become an instrument 
designer, as well as being a musician and performer.

The Proteus X and Emulator X Icons

At the beginning of each lesson you’ll see one or both of these colored 
icons. Because the Proteus X feature set is a subset of the Emulator X, these 
icons indicate whether the lesson is relevant to the Emulator X or for both 
products.
Emulator X / Proteus X - Advanced Applications Guide 7
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Fundamentals
   
Fundamentals
If you’re new to the Emulator X or Proteus X, this entire chapter will be extremely useful. 
By all means, we encourage you to actually program the Emulator X / Proteus X as you 
read. This is the best way to learn and remember how everything works.

You might want to give this chapter a quick scan even if you are familiar with the system 
as there are little tidbits of information scattered throughout.

Lesson 1 is a short review of synthesizer basics and explains the basic organization of the 
Emulator X and Proteus X. This short three page review is the only lesson in the book 
where you won’t be programming as you read.

Lesson 2 helps you get your MIDI continuous controllers programmed to your MIDI 
keyboard.

Lesson 3 walks you through the process of creating an entire preset from scratch. When 
you finish this chapter, you’ll be well on your way to mastering the Proteus X/Emulator X.
Emulator X / Proteus X - Advanced Applications Guide 9



Fundamentals
   
1 Basics: The Signal Flow of Emulator and Proteus X
The Emulator X and Proteus X have a fixed signal path following the basic 
synthesizer model used since the Minimoog. This model consists of three basic 
building blocks: Oscillator -> Filter -> Amplifier.

Oscillator (samples)
The oscillator generates the actual sound of a synthesizer. The oscillator’s pitch 
is usually controlled by a keyboard (as well as other devices, which we’ll get to 
later). In a traditional synthesizer, the oscillators generate a limited number of 
simple waveforms.

In the Emulator X and Proteus X, the oscillators have been replaced by Samples, 
or digital recordings. Unlike a traditional oscillator, samples can be any sound 
and any length. Samples can also be looped, so that any part of the recording 
can play indefinitely.

Filter
The filter modifies the sound by subtracting or accentuating certain frequencies. 
The tone control on your home stereo is an example of a simple filter. A synthe-
sizer filter has much more sound shaping ability and can be manipulated over 
time in complex ways by the special control devices in the synthesizer. The filter 
may also be referred to as a VCF (for the Voltage Controlled Filter on an analog 
synthesizer from which it is based).

The Emulator X/Proteus X contains over 50 different filter types. Some of these 
are traditional synthesizer filters such as Lowpass, Highpass or Bandpass filters. 
Lowpass filters let the low frequencies pass. Highpass filters let the high frequencies 
pass. Bandpass filters—you guessed it—let a specific band of frequencies pass.

The Emulator X/Proteus X also features a special type of filter called a morphing 
filter. Morphing filters are able to change their function over time. For example, 
a lowpass filter could change into a highpass filter during the course of a note.

Amplifier
The last audio building block is the amplifier. The amplifier shapes the volume 
contour of the sound over time. The amplifier may also be called a VCA (for 
Voltage Controlled Amplifier on older analog synths), or DCA (for Digitally 
Controlled Amplifier on newer digital synths).

Amp

Synthesizer Signal Path

FilterOscillator

Generates 
Sound

Modifies Frequency 
Content

Modifies 
Volume
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Fundamentals
   
Every sound has a characteristic volume curve that changes over time. Some 
sounds are percussive, such as a drum, a piano or a hand clap. Other sounds 
start slowly and build, such as a violin or a plane flying overhead. The device in 
a synthesizer that generates the volume curve is called an envelope generator.

Envelope Generator
An envelope can be described as a “contour” which can be used to shape the 
sound in some way over time. Think of an envelope generator as a device that 
automatically controls a parameter (such as volume) when a key is pressed. 
This would be like manually turning the volume control up and down when 
you press a key to create a certain effect. The envelope generator is programmed 
to do this automatically and in a repeatable way.

The traditional envelope generator contains four parts: Attack, Decay, Sustain, 
and Release, and is commonly known as an ADSR.

When controlling the Amplifier (volume) the ADSR works like this:

� Attack - Controls the time it takes the sound to reach maximum level.

� Decay - After reaching maximum level, the sound decays to the Sustain 
level at this rate.

� Sustain - The volume remains at this level as long as the key is held.

� Release - When the key is released, the volume decays to zero at this rate.

The Emulator X/Proteus X envelope generators are just like standard ADSR’s, 
except that they have two segments for each stage: a time and a level.
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Fundamentals
   
This is how the rate/level envelopes work: When a key is pressed, the envelope 
starts from zero and moves toward the Attack 1 Level at the Attack 1 Rate. As 
soon as it reaches this first stage, it immediately begins the Attack 2 phase and 
moves toward the Attack 2 level at the Attack 2 rate. As long as the key is still 
held, the envelope continues on through the Decay 1 and Decay 2 stages. If the 
key is still held when the envelope reaches the end of Decay 2, it simply stops 
and waits for you to release the key. When you release the key, the envelope 
continues through its Release 1 and Release 2 stages, returning to zero at the 
end of the Release 2 stage. The rate/level envelopes give maximum flexibility to 
program both complex and simple envelopes.

The envelopes and other controllers are connected to the sound processing 
blocks using software Cords. Cords have a built-in bipolar amount control. 
(No, they’re not schizophrenic!) The amount goes from -100 to +100. If the 
amount is negative, the control signal is inverted. The Cords provide 
tremendous flexibility because they allow almost any possible connection 
between the various control and processing modules.

So there you have it! There are three basic sound processing modules: 
Oscillator, Filter and Amplifier. The Envelope Generators and other 
controllers are connected to the processing modules using Cords, which have a 
built-in amount control.

An oscillator can be ANY sound. Samples are imported or recorded, then 
shaped using the various filter types and the amplifier using the envelopes and 
other controls. The possibilities are truly staggering!

In creating a synthesizer sound you become an instrument builder. Your job as 
builder is to combine the various elements together and add various types of 
control so that the instrument responds in a musically satisfying way. So let’s 
continue now and build a preset completely from scratch.

Amp

L

R

LFO
(x2)

MIDI
Controls

Envelope
Gen (x3)

Other
Key #

Velocity
Gate

Re
tr

ig
g

er
Pi

tc
h

Lo
o

p

Frequency Q

Vol

Pan

C
h

o
ru

s

G
lid

e

St
ar

t 
O

ff
se

t

Voice

- 36 Cords -

Filter

Controllers

Function
Gen (x3)

Sample
(Oscillator)
12 EMU Systems, Inc.



Fundamentals
2   Assigning Continuous Controllers
2 Assigning Continuous Controllers
Before we go any further, lets route the Controller Knobs on your MIDI 
keyboard to control the Proteus X /Emulator X. We’re assuming that your 
keyboard has controller knobs and that it is connected to the Proteus X / 
Emulator X and plays notes.

Check out the Situation

1. Start by loading any bank. The main 
preset selection window appears with 
the 16 controllers shown.

2. Turn the knobs on your keyboard. Do 
any the knobs on the Proteus X /
Emulator X move in unison? If so, 
your keyboard knobs are correctly 
assigned. If the screen knobs don’t 
move or they don’t control the knobs 
they way you want, read on.

The Way Continuous Controllers (CCs) Work

Most of the MIDI gear today is so flexible that it actually makes things more 
complicated than it need be. Continuous controller assignment is a good 
example of this.

When you turn a knob on your keyboard, it sends a continuous controller (CC) 
message on a specific CC channel that tells the receiving device (the synthe-
sizer) that the knob moved to a new value. Each knob on your keyboard has to 
have its own CC channel, otherwise all the knobs would control the same 
parameter.

The confusion comes in because the BOTH the keyboard and the Proteus X / 
Emulator X can freely assign knobs to ANY of the CC channel numbers. In 
order for the keyboard and synth to link up correctly, the channel numbers 
of the controllers on BOTH DEVICES MUST MATCH.

Preferences
(Options, Preferences Controllers)

MIDI Keyboard

Controller
Knob data

2. Set the CC numbers to match 
those of your MIDI Keyboard. 

1. Each Knob on your Keyboard 
sends is assigned a CC number. 
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The way a keyboard assigns its knobs to CC channels depends on the brand of 
keyboard. In order to get the two units talking to each other you’ll have to 
either:

a. change the controller numbers that your keyboard sends to match the 
Proteus X / Emulator X, or...

b. change the controller numbers that the Proteus X / Emulator X receives.

� We can tell you how to change the CC channels on the Proteus X or 
Emulator X, BUT you still have to know what CC channels your keyboard is 
transmitting.

To Program your Keyboard to Match the Proteus X or Emulator X

1. Change the controller numbers for the knobs on your keyboard so they 
match the numbers in the Proteus X / Emulator X screen shown below.

2. Try out the knobs as described in steps 1 and 2. If they now work, you’re all 
finished. If the keyboard works but not the knobs, you still have a CC 
number mismatch. Try again.

 To Program the Proteus X / Emulator X to Match Your Keyboard

If your keyboard knobs are already working properly with other software or 
synths, you’ll probably want to change the Proteus X / Emulator X controllers 
to match your keyboard. Here’s how.

1. Find out the CC channel of each knob on your keyboard. You may want to 
write these down.

2. On the Proteus X / Emulator X, select Preferences from the Options dialog 
box. The preferences dialog box is divided into four main groups. Click on 
the Controllers tab heading. The screen shown below appears.

3. The default controllers settings for the Proteus X or Emulator X are shown 
above. (Pressing the Use Defaults button resets these settings.) The screen sets up 
which MIDI Continuous Controllers Proteus X /Emulator X will 
14 EMU Systems, Inc.
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receive.Match these controls to the MIDI continuous controller numbers 
that your keyboard transmits.

4. Click OK to close the Preferences.

5. Try out the knobs as described in steps 1 and 2. If they now work, you’re all 
finished. If the keyboard plays notes, but the knobs still don’t change the 
on-screen knob positions, you still have a CC number mismatch.

More Information About Proteus X / Emulator X CC Numbers

You might have noticed that MIDI Continuous Controller numbers are 
assigned to letters (A-P) or labels (Pitch, Mod, Pressure, Pedal, etc.) in the 
Controller Preferences screen.

When programming the Proteus X/Emulator X, these letter or name labels can 
be assigned to control various parameters such as filter frequency or attack 
time. If you’re using the Factory Sound Banks, the knob programming is done 
for you. Now that you have your knobs connected, you can start playing.

 

Preferences

Voice Processing Cords

(Options, Preferences Controllers)

MIDI Keyboard

Controller
Knob data

1. Select the CC 
numbers you 
wish to receive. 

2. Assign the controller 
letters to Synth 
destinations. 

Continuous controller numbers
are assigned Letters (A-P)
& Labels (mod wheel, etc.)

The Controllers screen determines which CC numbers (knob controller data) the Emulator X will receive. 
What the knobs actually do to change the sound can be programmed differently for each preset 
(Voice Processing).

Controller Knob Assignment
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3 Building a Preset from the Ground Up
In this tutorial we’re going to start with an empty bank and create a complete 
preset using some of the samples in your library. Along the way you’ll learn:

� How to locate samples from your library and load them into the bank

� How to place samples on the keyboard

� How to stretch samples across the keyboard

� How to apply various types of processing to the samples

� Locate Samples and Load them into the Bank
1. Make sure you have either the Proteus Composer or Proteus X Composer 

bank on your hard disk.

2. Let’s start with a clean slate. Select New from the File menu.

3. The easiest way to find samples is using the Library feature. Click the 
Library Tab at the bottom of the Tree.

� Important: If the Librarian doesn’t find the samples, select Update Library 
from the File menu. (You need to have Proteus X Composer in your System.)

4. Select Vocal as the Category, then type “aah” in the ‘Filter by Name’ box. 
Click Search. (Note spelling of aah!)

5. Clicking on the Samples Folder in the Tree displays the expanded list in the 
main window.

Library Tab
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6. The window should look something like the one shown above, although 
you may have more samples shown, depending on the size of your sample 
library.

7. Locate the following samples: Aahs A2, Aahs C3, Aahs C4, Aahs D#2, Aahs 
D#3, Aahs D#4, Aahs F#3, Aahs F6. Can’t Find? Check the spelling: “Aahs”

� Tip: Select multiple continuous samples by pressing on the Shift key while 
selecting items. Select multiple non-continuous samples by pressing the 
Ctrl+W key while selecting items.

8. Select the samples listed above and while holding the mouse button, drag 
and drop them on top of the Emulator X/Proteus X icon above the Tree.

9. Click the Sampler Tab at the bottom of the Tree, then double-click the 
Samples Folder to open it. You’ll notice that the samples have now been 
added to the Bank.

10. Click on one of the Sample icons in the Tree.  The Sample Editor appears 
with one of your Aahs waves displayed.

Drag and Drop

Loop Start 
Marker

Loop End 
Marker
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11. The sample is of a fixed length. So that the sample will play for as long as 
you hold a keyboard key, the sample is looped. Notice (but don’t change) 
the Start and End Loop Markers.

12. Looping is a subject for another tutorial. At this point, let’s move on to the 
next step in building a Preset, and place the samples on the keyboard.

Time to Save?

13. It’s time to save whenever you have done enough work that you’d HATE to 
lose it. Now would probably be a good time.

14. Select Save As... from the File menu, choose a location where you can find 
it again (the desktop?), and press Save. Don’t you feel better?

� Placing the Samples on the Keyboard
1. Click on the Presets Folder in the Tree, then select New Preset (Ctrl+W) 

from the Presets menu. A new preset appears in the Tree.

2. Select Voices and Zones in the new preset. The Voices and Zones page 
appears.

3. Select Aahs A2 from the list in the Tree, then drag and drop it anywhere in 
the Key Win area as shown below.

4. A new voice named Aahs A2 appears in the window. A green bar appears 
across the entire keyboard range indicating that the sample is transposed 
across the entire keyboard. The red bar shows the original key. Because the 
original pitch of the sample (A2) is included in the name, Emulator X/
Proteus X is smart enough to place the original pitch on the proper key.

� Important: If the original key of a sample is 
on the wrong key, the sample will be out of 
tune. The original key selection field is 
always visible regardless of which tab is 
selected.

5. Play the keyboard. Since the sample is transposed over the entire keyboard 
range you can play it polyphonically at any pitch. But as you play in the 
upper part of the keyboard, notice that the sound doesn’t sound so natural 
anymore. This is a result of the sample transposition. To overcome this 
problem we add more samples.

� Tip: Choose Ultra-High Precision Interpolation in the Audio Preferences 
for the best sample transposition at the expense of reduced polyphony.

Original Key Selection
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6. This time, let’s use a different method of assigning samples. This method is 
useful if the original pitch is NOT included in the sample name. Select Aahs 
D#2 from the list in the Tree, then drag and drop it over the D#2 key on the 
keyboard at the bottom of the window.

7. A new voice named Aahs D#2 appears in the window on note D#2.

8. Continue placing the rest of the samples. Practice using both methods.

9. Select the Key Win tab. This window graphically displays the current sample 
to keyboard mapping. Depending on the way you placed your samples, the 
display might look something like this. The red bars show the original keys.

10. Notice that the top voice has no sample. This empty voice was created when 
you created the Preset. We won’t need this voice and can get rid of it. Select 
the empty voice by clicking on it. It becomes highlighted in red. Press the 
Delete key on your keyboard to delete it.

11. Also notice that the original keys of our voices are all over the place. Let’s 
rearrange the voices by the position of the original keys. From the Preset 
menu, select Sort Voices, By Original Key.

Drag and Drop

Original Keys

Empty Voice
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12. Now the voices should be arranged like the screen below.

13. Next, we need to give each sample its own keyboard range. Click on the 
original key of Aahs D#2 and drag it all the way to the left.

14. You can also adjust the key range using the key range controls in the lower 
right corner of the window. Click the inc/dec buttons and note that the 
graphic display follows. The Key Range display shows the currently selected 
voice. The Key Range Controls allow you to select multiple voices and 
change them all to a single value if so desired.

15. Adjust the range of all your voices until the display looks like the one 
below. Make sure that none of the voices overlap each other and that all the 
keys are covered.

16. Play the keyboard. The choir sounds much more realistic, especially in the 
middle range.

Time to Save?

17. It’s time to save again. This time just select Save (Ctrl+S) from the file 
menu.

Click & Drag

Key Range
Controls

Inc/dec 
buttons
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� Apply Voice Processing
Now that we have our samples arranged, we can continue to refine our preset 
using the filters and amplifier.

1. Select the Voice Processing page by clicking the Voice Processing icon in the 
Tree.  The Voice Processing page appears. See the screen below.

2. In the Emulator X/Proteus X, each voice is a 
complete synthesizer with its own set of param-
eters. In most cases, you’ll want to treat the voices 
as a single synthesizer. Select All voices from the 
Group box above the keyboard in lower part of 
the window. 

� Important! Selecting the proper voices to modify is a KEY operation and 
it’s easy to get confused. If the synthesizer controls don’t seem to be 
working correctly, check to make sure you have the correct voices selected. 
The Back Arrow allows you sequentially undo the last operations.

Amplifier Envelope

3. Our choir sounds pretty good, but the sound turns on abruptly like an 
organ. Let’s increase the Attack Time a little so that the voices swell up when 

Select All

Amp
Envelope

Attack 1 Knob Release 1 Knob
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we press the keys. The Amplifier has its own dedicated Envelope Generator 
and it’s already selected. Set the Attack 1 knob to about .5 seconds.

4. Much better! Let’s increase the Release Time so that the sound dies away 
slowly when the keys are released. Set the Release 1 Time to about 1 
second. Heavenly!

Clear the Cords

5. Before we begin, take a look at the Cords section 
for a second. Cords are the virtual wires that 
connect everything together in the Emulator X/ 
Proteus X. A bunch of Cords are already connected 
to their default connections. We don’t want or 
need these Cords, so let’s get rid of them.

6. Right-click anywhere inside the Cords section. 
A pop-up selection box appears. Select All Off to clear all the Cords. Poof!

� Note: Unused Patchcords use CPU cycles. If you’re not using a cord, it 
might be a good idea to disconnect it (both source and destination).

Phaser Phun

7. Now let’s add a filter effect. Select Phaser 1 from 
the Filter Type menu. This filter simulates a tradi-
tional phase shifter by creating two deep notches 
in the frequency spectrum. Leave the Frequency 
and Resonance settings at 0.0 for now.

8. Let’s add a bit of movement to the filter by 
connecting an LFO to the Filter Frequency. An 
LFO or Low Frequency Oscillator is simply an 
wave that repeats slowly. The LFOs have a range 
of .08 Hz (12.5 seconds per cycle) to 18 cycles 
per second.

9. Click on the fields to select source and 
destination for the cord. Set-up Cord 1 as 
shown at right with LFO 1+ as the source, 
Filter Frequency as the destination, and 
an amount of around +40.00.
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10. A block diagram of the connection you just made is shown below.

11. Play the keyboard and you’ll hear 
the phaser filter sweeping the two 
notches across the frequency 
spectrum.

12. Let’s tweak the LFO a bit. Select the 
LFO/LAGS page by clicking on the 
LFO/Lags tab. Set the Frequency to 
about 0.9 Hz and change the 
Shape to Sine.

13. If you have trouble adjusting with the knob, try typing the value into the 
numeric field. Once the numeric field “has the focus” you can use the up/
down keys on your computer keyboard to increment or decrement values.

14. Now the effect is a lot more subtle. Increase the Filter Frequency to about 
25 to “zero-in” on the main group of frequency components. Feel free to 
tune the filter to your own taste. You can also adjust the Cord Amount 
along with the Filter Frequency to get the effect you want.

15. The Resonance control (Res) adds resonant peaks and deepens the notches 
in the filter. Try it out.

16. Explore a little on your own. Go ahead and try out different LFO wave 
shapes, or different filter types. (Be careful. Some of the filters have extremely 
high gain at certain frequencies and they may distort with the harmonically-dense 
voice samples.)

� Load an Entire Preset
Now we’re going right back to where we started, but instead of loading 
individual samples, let’s load a complete Preset.

1. Select the Library Tab in the Tree.

2. Select Keyboard 1 as the “Filter Category” and type in piano in the “Filter by 
Name” box. Click the Search button.

Freq.

40

Q

Filter

Cord

LFO

Phaser 1

LFO/Lags

Shape

Frequency
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3. Double-click on the Presets folder in the Tree to open it. You should see 
several piano presets there.

4. Select one of the piano presets then drag and drop it over the Emulator X or 
Proteus X icon above the filter selections.

5. Switch back to the Sampler Tab beneath the Tree and see your piano preset 
in the bank.

6. Select the piano preset and play the keyboard. That was easy!

7. Save the bank.

Signing Off

We’ve covered a lot in this lesson. Now you know how to create a preset from 
samples and how to create a custom bank from the presets in the library. This is 
a very ‘deep’ instrument, so don’t expect to learn it all in one day. Explore a 
little at a time and most of all don’t forget the music, because that’s what it’s all 
about. Have fun!
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4 Easy Sound Creation using Links
Preset Links allow you to easily combine multiple presets into layers or 
keyboard splits. You can switch or crossfade sounds based on either key 
position or key velocity.

� Create a Stacked Preset:
1. Load any bank of presets.

2. From the Sampler Tab of the Tree, click on the Presets folder.

3. Select Preset -> New Preset to create a new blank preset. "Blank Preset" will 
appear in the Tree. (Hint: Look at the bottom of the list.)

4. Rename your new preset

5. Double-click on the plus sign of your new preset to open it. The Voices & 
Zones, Links and Voice Processing branches appear.

6. Click on the Links icon. The Link window appears.

7. Select Links -> New Link to create a new blank link.

8. Click on the Preset button to the right of the preset field.

9. Select a preset.

10. Repeat steps 6 through 9 to add another preset.

Since the keyboard ranges of the two presets cover the entire keyboard, both 
sounds play whenever you press a key. This is called a “stacked” preset. If you 
wanted to create a keyboard “split” with one sound on the lower half of the 
keyboard and another on the top half, simply adjust the keyboard ranges of the 
two preset so they don’t overlap. It should look something like this:

� Tip: To crossfade the key ranges, hold the Crtl key on the computer 
keyboard and drag one end of the bar (or type in a fade amount).

� Note: When linking presets, the Initial Controller settings of the first preset 
are imposed on the linked preset. This may change the sound of the linked 
preset. Sometimes switching which preset is the Link will correct the 
problem. If this doesn’t work you will have to edit the Initial Controller 
settings until both presets sound the way you want.

Split Keyboard
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� To Crossfade between two Presets based on Key Velocity:
1. Set the key range of both presets to cover the entire keyboard.

2. Press the Vel Win (velocity window) button.

3. Adjust the Velocity Range for each preset while playing the keyboard so that 
a smooth transition is heard between soft and hard key velocities. See the 
example below. You may have to adjust the volume of one or both presets 
(Mix/Tune) to achieve a smooth transition.

Subsume!
If you like the way you new linked preset sounds and want to make it 
permanent, you can use the Subsume Links command (found in the Links 
menu). This handy feature copies the voices from the linked preset into the 
current preset and then removes the links.

Velocity Crossfade
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5 Sampling and Chopping Samples
This tutorial walks you through the process of sampling, sample chopping and 
then placing the multiple samples on multiple keys. A good way to practice is 
by sampling your voice speaking a phrase, since the chopper is designed to 
separate individual samples from a continuous recording.

� Import or Acquire your Samples
1. Select New (Ctrl+N) from the File menu to create a new empty bank.

2. Select Acquire Samples... (Ctrl+Q) from the File menu. The Acquire/Chop 
Samples window appears.

3. If you want to record a new sample, press the Record... button. If you want 
to load an existing .wav or .aiff file, press the Load... button. Load brings up 
a standard Windows browser where you select the sound you want load. No 
problem right? In the next few steps we’ll walk you through the process of 
sampling a new sound.

4. After pressing Record..., the Record Audio window appears.
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Get Ready to Sample

5. Select the input you wish to use and verify that the meters show signal. Press 
the Monitor button to hear the input signal while recording.

6. Press the red Record button  to begin recording. Press the Stop 
button  or the Spacebar to stop recording.

7. If you are happy with your sample press Done. The Record Audio window 
disappears and the sample appears in the Acquire/Chop Samples screen.

8. The display should look something like the one shown below where we 
have sampled a spoken phrase.

9. The Gate/Chop controls are designed to automatically separate the samples 
and this feature works well if the individual samples are separated by 
silence. In the case of speech, it doesn’t work so well because of the 
complexity of the waveform. Too many gates are chose.

10. You can go ahead and try the auto Gate/Chop with your sample by pressing 
the Apply button. Press Delete to clear the gates. Adjust the Level setting 
and press Apply to try again.

 Setting the Gates Manually

11.  Press Delete to clear any gates you may have created with the previous 
step.

12. Press the Play from Start button to listen to your sample again. Note 
the approximate location of each word in your spoken phrase (sample).

Automatic
Gate/Chop
Controls
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13. Click and drag across the first word in your phrase. Sample Gates appear at 
the sample boundaries when you release the mouse button.

14. Press the Play button to hear just the Gated area of the sample.

15. Adjust the Start and End Gates as necessary to zero in on the section you 
want.

16. Repeat steps 13-15 until you have all the individual words (if you sampled 
speech) isolated.

17. As you’ve been selecting the Gates, you’ve probably noticed that new 
Regions have been added to the list below the waveform display. Click on 
the Region Name to select it in the waveform display. Click the Play button 
to hear the selected Region.

Click & Drag

Sample Gates

 View All
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18. To delete a Region, select it and press the Delete button on your computer 
keyboard.

19. If you wish, you can name the Regions now. Click on the region name and 
type.

20. When you have all the Gates set the way you want them, click the Select All 
button.

21. Press the Save To Sampler button. The pop-up dialog box shown below 
appears.

22. Set-up the options as shown above, then click OK. The selected Regions are 
exported into the Emulator/Proteus X.

23. Click Done to close the Acquire/Chop Samples window. The Samples 
appear in the samples folder.
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Make a Preset

24. Select the Presets folder in the Tree.

25. Select New Preset from the Presets menu (Ctrl+W), or by Right-clicking on 
the Presets folder. A new empty preset appears in the Tree.

Place the Samples on the Keyboard

26. Select Voices and Zones in the new preset. The Voices and Zones page 
opens.

27. Click and drag the samples from the Sample folder in the Tree down to the 
keyboard at the bottom of the Voices and Zones page. See the diagram 
below.

28. Congratulations! You’ve just created a preset from scratch. A new voice is 
created for each sample you placed.

29. Play your MIDI keyboard to verify that the samples play.

30. If you want to change the location of the samples, click the Key Win tab. 
You can select the key range of each voice by typing in the selection area in 
the lower right section of the page, or by dragging the bar in the graphic 
display.

31. Be sure to Save the Bank if you want to keep your work.

Further Explorations
Each of the voices you just created has its own set of synthesizer parameters.

To modify the voices

32. First select the Voice Processing page. To modify all the voices select All as 
the group.  You’re in! Start tweakin’.

33. To modify each voice separately, first assign each voice to a different group 
in the Voices and Zones page, then select the individual voice you want in 
the Voice Processing page.

Click & Drag samples to the 
desired keyboard locations.
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6 Importing from an Audio Sound Library
Aside from commercial sound libraries, there are literally thousands of samples 
available free or at a nominal cost on the internet. In addition, electronic music 
magazines such as Computer Music and Sound-On-Sound occasionally give 
away CDs or DVDs containing quality audio samples. 

Using the Auto-sampling (ASAP) and Acquire features of the Emulator X you 
can slurp up these free samples and automatically create great custom presets.

� Before you begin, locate a source of .wav samples. We’re using a DVD 
sample collection included in a recent issue of Computer Music magazine.

� To Import a Batch of .wav Samples:
1. Let’s start with a clean slate, so run the Emulator X (standalone) and select 

New (Ctrl+N) from the File menu.

2. So you’ve located a folder of .wav or .aiff samples you want to import from 
a sample CD. We’ve selected a group of PPG Bass samples from the DVD.

3. You could audition these .wav files first using WaveLab or Windows Media-
Player, but it’s so easy to import them into the Emulator X, why bother?

Import

4. To import the samples, simply select the whole batch 
and drop them on top of the Emulator X icon above 
the Tree. A little  appears below the cursor indicating 
that the samples are being added to the bank.

5. The Import Samples window appears with the new 
samples listed.
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Set Keys
6. If the pitch information is embedded in the .wav file or if the original key is 

contained in the sample name (as they are in our samples), the Emulator X 
automatically fills in the Original Key field.

� Setting the proper Original Key is important because this determines the 
tuning of the samples when they’re assigned to the keyboard.

7. If the original key is not automatically filled in, you can 
choose another method for selecting original keys in the 
Set Keys box. Use Pitch Detect for pitched sounds. Use 
White Keys or Chromatic for percussion or sound effects 
when you want a different sample on every key.

Automatic Sampler Options

8. These samples have probably already been normalized, so we’ll leave this 
feature turned Off.

9. Since these are synthesizer samples, they’ll probably be 
pretty easy to Auto-loop. We’ve guessed 1/3 with no 
Crossfade looping for these sounds. Some sounds, such as 
strings, are more difficult to loop without getting ticks. 
Crossfade looping smooths out the differences at the loop 
points, but modifies (smears) the original wave when 
doing so. Crossfade Loops should be used as a last resort.

Set
Original 
Keys

Auto 
Sampling
Options

Auto 
Preset 
Options
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Build a Preset

10. Turn Build Preset On and set Stretch to Up and Down. This option fills in 
the keyboard above and below the original key.

11. Placement should be set to Original Key. You could also Name your new 
preset now if you so desire. Single Voice (Multisample) should be 
unchecked (Off).

12. Press the Import button to complete the process. A progress bar appears as 
the samples are imported.

13. Voila! A new preset has been created. Play the keyboard.

Sound Sculpting

14. Now let’s do a few quick modifications to the 
sound in the Voice Processing page. Click on the 
plus symbol  next to your preset in the Tree to 
open the preset.

15. Next, select the Voice Processing  page by clicking the icon. 
The Voice Processing page contains the synthesizer controls.

Voice 1 Voice 2 Voice 3

Sample 01 Sample 02 Sample 03

Up
& 

Down
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Using Templates

The easiest way to change the synthesizer settings is by using the Templates. 
Templates let you save useful settings for each synth module. The Emulator X 
comes pre-loaded with templates you can use.

16. Right-click anywhere in the Amp Envelope 
section. A pop-up list of Templates appears.

17. Try out String Pizz - Amp, which gives you a 
percussive envelope. Find one you like.

The Filter

18. Select 4 Pole Lowpass as the filter type and set 
the filter frequency to about 500 Hz.

19. Turn up the amount of Patchcord 6 to about +60. 

20. Click the Filter Env tab,  then Right-click over the envelope section 
to bring up the list of Templates.

21. Select Falling Sweep from the template list and listen to the sound.

22. Now adjust the Filter Frequency, Filter Q and Filter Env Cord Amount to 
your own taste. These are the “big three” synth controls. Master these and 
you can rule the world!

23. We’re going to leave you to your own devices (no pun intended) at this 
point. Remember to Save the Bank or all your work will be lost.

24. Feel free to try out the Templates for the other synthesizer modules and 
don’t forget the Effects. Making presets is easy when you know the tricks.
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7 Patchcord Programming - Vibrato & Tremolo
Patchcords are a common source of confusion, but they really shouldn’t be, 
because they are very easy to understand and use. Patchcords are used to 
connect modulation sources, (such as an LFO, MIDI controller knob or an 
envelope generator) to the thing you want to change (such as pitch, volume, 
filter frequency, or even another patchcord).

The easiest way to understand how the patchcords work is to examine one of 
the factory presets. In preparation for this tutorial, load up the Proteus 
Composer bank.

Examine a Factory Preset

1. Select P0015 Dyna-heim from the Tree by clicking on 
the little keyboard. 

2. Next click on the (+) symbol to open the preset modules.

3. Click on the Voice Processing icon . The Voice 
Processing (synthesizer controls) module appears.

4. Check to make sure the Voice Selector reads “All”. This 
is to make sure that the changes you make will affect 
all voices in the preset. All the settings on this page can 
be different for each voice in the preset. With the 
selector set to “All” you will be modifying all voices.

2. 1.

3.
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5. Patchcord number 2 has LFO 1 connected to 
Pitch with an amount of +1. This creates a very 
slight vibrato.

6. Turn up the Patchcord Amount and note the 
effect when you play a key. Afterwards, set the 
amount to zero (0).

7. Note that Patchcord #1 has the Mod Wheel 
connected to Cord 2 Amount. This cord allows 
the modulation wheel on your controller to 
turn up the LFO amount being sent to Pitch, 
just as you did manually in step 6.

� Note that the Amount setting of Cord 1 deter-
mines the MAXIMUM amount of modulation 
that can be applied using the Mod Wheel.

� Controlling the amount of a Patchcord with another modulation source is a 
fundamental concept in Emulator X and Proteus X.

Modify the Patch

8. Select LFO 2+ instead of the Mod Wheel for Patchcord Source 1. (You might 
want to decrease the frequency of LFO 2 to hear the effect better.)

9. Try patching different modulation sources to control the amount, such as 
the Aux. Env., Velocity, Pink Noise, Key Random.

Tremolo

Tremolo is Volume Modulation (instead of pitch modulation as in vibrato) 
and is usually implemented using an LFO to cyclically change the volume.

10. Simply change the destination of Patchcord 2 to Amp Volume (turn up the 
Cord Amount) to hear this effect. The Mod Wheel is commonly used to 
control this effect as well.

Auto-Pan

Auto-Panning is simply Pan Modulation and creating this effect is a simple 
matter of changing the Patchcord.

11. Simply change the destination of Patchcord 2 to Amp Pan to hear this 
effect. You can use the Mod Wheel is commonly used to control this effect 
if you wish.

Source Destination
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8 Connecting a Volume Pedal
Connecting a continuously variable controller pedal to your MIDI keyboard 
allows you to control any parameter without taking your hands off the 
keyboard. In this example we’ll get the pedal connected properly and set it up 
as a volume pedal.

� To Connect the Pedal and Set the MIDI Controller Number:
1. Connect a continuously variable control pedal to your MIDI keyboard 

controller.

� Important: You must use a pedal that is compatible with your keyboard. 
Control pedals can be wired in several different ways. An incompatible 
pedal probably won’t cause any damage, it just won’t work.

2. Set up your MIDI controller to transmit the Pedal input as MIDI continuous 
controller Number 4. (This is the default setting in the Emulator X/Proteus 
X.) The important point here is that the pedal CC number sent by your 
keyboard MUST match the number programmed in the Preferences, 
Controllers menu in Emulator X/Proteus X.

� To Program the Pedal to Control Volume:
1. Select Any Preset from the Tree by clicking on the little 

keyboard. 

2. Next click on the (+) symbol to open the preset modules.

3. Click on the Voice Processing icon . The Voice 
Processing (synthesizer controls) module appears.

Foot Pedal

Footpedal

2. 1.

3.
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4. Check to make sure the Voice Selector reads “All”. This 
is to make sure that the changes you make will affect all 
voices in the preset. All the settings on this page can be 
different for each voice in the preset. With the selector 
set to “All” you will be modifying all voices.

5. There are four pages with nine Patchcords each. Browse through the pages 
using the Page Selector buttons until you find an unused Patchcord (one 
that is turned Off).

6. Program the unused Patchcord so that Pedal is being sent to Amp Volume. 

Set the Amount to 100%. Like this: 

7. The last step is to turn down the initial Amp Volume. This silences the 
output unless the Pedal is depressed, turning the volume up. 

8. That’s it! Try out your new volume pedal.

Not Working? Check the following:

� Make sure your controller is sending on the proper MIDI Channel and the 
CC number for the Pedal is CC#4.

� Is Pedal set to 004 (Pedal) in the Emulator X/Proteus X Preferences?

� Try changing the Cord destination from Amp Volume to Pitch. Do you 
hear the pitch change when you move the pedal?

� Make sure you have ALL voices selected in the Voice Selector.

Page Selectors

Set to 
-96dB
(off)
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9 Programming a Filter Pedal
Using a pedal to control the filter gives you a huge amount of expressive control 
over the sound without ever taking your hands off the keyboard. With the huge 
variety of filter types available on the Emulator X/Proteus X you can do 
anything from a simple tone control to complete sound transformation with a 
flick of the toe.

� To Set up a Filter Pedal:
1. Setting up a Filter Pedal is a lot like setting up a Volume Pedal, so first follow 

the instructions given in the previous example “Volume Pedal” up to step 5, 
then continue.

2. Change the Pedal Cord Destination to Filter Frequency. Set the Cord 
amount. The amount determines “how much” the pedal will affect the filter 
frequency. If you want just a slight amount of control, set the amount to a 
low value; if you want a lot of control, set it to 100%.

3. Choose a filter type. A 2 or 4 pole lowpass filter will give good results, but 
you can use any filter you like.

4. Lower the Initial Filter Frequency as shown in the screen below. (The pedal 
is going to add to the initial value and if the frequency is set too high you 
won’t hear anything.)

5. Work the pedal while you play and you should hear the filter sweeping. If 
not, try another filter type and re-adjust the initial filter frequency.

� MIDI Controller A in the factory presets also affect the filter frequency and 
may need to be adjusted.

� An easy way to modify a factory preset for a filter pedal is simply to change 
the source of the cord MIDI A to Pedal.

� To Reverse the Filter Pedal: Use a negative cord amount, then re-adjust the 
initial filter frequency.

Lower the initial frequency.

� The Initial Frequency determines 
the tone when the pedal is Up.

� The Cord Amount determines the 
tone when the pedal is Down.
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10 Exploring the Twista Mania Bank

� Exploring TwistaLoop
The easiest way to check out TwistaLoop is by exploring the Twista Mania bank 
included with your Emulator X2. This bank contains 37 beats with all 16 
controllers assigned in interesting ways. So let’s check it out.

1. Start by loading the Twista Mania bank. Twista Mania has only one preset 
with a different groove assigned to each key.

What does TwistaLoop do?

2. First of all, just play up and down the keyboard checking out the beats. 
Notice how the beats are synchronized when you play two or more keys 
together. Also notice that if you move the Pitch Wheel, the pitch changes, 
but the beats don’t change tempo.

3. To get a better idea of what TwistaLoop is doing, 
turn TwistaLoop Override Off on the main page. 
Now the beats play at their natural tempi and 
playing two or more together sounds like a train 
wreck!

4. Set TwistaLoop Override back to “-Not Set-”. In case you’re wondering, 
TwistaLoop Override simply allows this setting to take precedence over all 
others. You can turn it On, Off, or -Not Set- (i.e. let the preset or voice 
setting decide).

5. Try changing the Master Tempo using the Emulator X 
tempo control. Notice that the beats all track the tempo 
changes over a fairly wide range. (Note: If this control is 
“greyed-out”, turn “External Tempo Source” Off in the 
Preferences menu - Options, Preferences, MIDI.)

Try Out the Controllers

6. The 16 controller knobs are pre-
programmed to show off the 
TwistaLoop features. You can 
select which loop plays in each 
groove or selectively mute certain 
beats. Up to five DSP effects can 
also be added.

The easiest way to explore Twist-
aLoop is to find a groove you 
like, then mutate it using the 
knobs on your keyboard.
 
(You have assigned your controller knobs, haven’t you? If not, see page 13.)
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7. The labels give some clue as to their function, but they really deserve a more 
complete explanation. Please refer to the chart below.

8. Loop Select (L Select) shows off one of the ways you can select multiple 
loops. Because you can selectively loop any section of a recorded drum 
groove, you can turn a few seconds of drumming into an entire song.

9. To try it out, just play a note and twist a knob. The next loop will start when 
the currently playing loop finishes.

10. Now try out the Pitch Control. You can actually re-tune the drums in real-
time without changing the tempo.

11. Function Generators 1-3 have been programmed to cut out certain notes as 
the knob is turned up. This is another way you can modify existing drum 
beats to make them your own. FG 3 dynamically changes the panning.

12. Try adding some effects. There are five effects programmed in this bank.

13. Then there is the Filter Cutoff and Q, and don’t forget that you can select 
any filter type with the Filter Override control.

On Your Own

Now you have some idea of what TwistaLoop can do. Check out the next 
tutorial to learn how to create your own TwistaLoop beats.

Controller What the Control Does

Filter Changes the Filter Cutoff Frequency

Filter Q Changes the Filter Q (Resonance)

L Select Selects which loop plays. Each groove contains from 6-8 different loops.

Pitch Changes the pitch of the grooves without changing the tempo.

Attack Changes the Attack time of each key press (but not each drum attack in the 
grooves).

Decay Changes the Decay time of each key press.

Sustain Changes the Sustain Level of each key press.

Release Changes the Release time of each key release.

FG 1 Mutes every other 16th note.

FG 2 Selectively mutes some 16th notes.

FG 3 Widens the Pan Position every 8th note.

Aux 1 Reverb Amount

Aux 2 Delay (BPM) Amount

Aux 3 Tube Amount

Flanger Flanger Amount (Preset Effect. To Edit: Click the Preset icon in the Tree.)

Growl Growl Amount (Preset Effect. To Edit: Click the Preset icon in the Tree.)
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11 Building Your Own Filters
The Morph Designer allows you to combine 
up to six, 2nd-order filter sections (lowpass, 
highpass or EQ) and then morph between 
two completely different settings on each of 
the six sections.

Any of the six filter sections can be designated 
as either a lowpass, highpass, or EQ filter. You 
then set the filter Frequency and Gain/Q for 
both the low and high positions of the Morph 
control. When the Morph control is changed, all the filter controls interpolate 
between the low and high settings you programmed. This reduces twenty-four 
knobs to just one extremely powerful control.

The Gain Controls (Important! Read this.)

� The lower Gain wheel affects the gain if the section is an EQ.
If the section is a HP or LP filter, the Gain wheel changes the Q.

� The small Gain knobs control the Gain/Q of the selected filter section.

� The Gain wheel adds a Gain or Q Offset to all filter sections.
(clipping at 0 or 100%) In other words, it ADDS to the Gain/Q setting 
programmed in each section.

� IMPORTANT: Set the Gain/Q Wheel in the center while programming your 
Morph Designer filter, and use the Morph control to sweep the filter.

� Explore the Morph Designer:
It’s easy to create great sounding filters using just 2 or 3 
filter sections.

1. Select any preset with lots of harmonic content.

2. Go into the Voice Processing window, select all 
Groups and select Morph Designer as the filter 
type.

Lo
Morph

Hi
Morph

1 2 3 4 5 6

LP EQ EQ EQ EQ HP

Filter Stages
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3. Turn MIDI Controller A all the way down on your MIDI keyboard.

First Filter Section

4. Select LP as the shape for filter Stage 1.

5. Turn the Morph Wheel all the way down. (Select the Wheel, then press Home.)

6. Set the Gain Wheel to its center position. (Alt+click the mouse on the control.)

7. Set the Frequency and Gain controls of the Lo Morph all the way down.

8. Turn the Morph Wheel all the way up. (Select the Wheel, then press End.)

9. Set the Frequency and Gain controls of the Hi Morph to their maximum 
settings.

10. Now play the keyboard and turn the Morph wheel. You have just created 
the classic synthesizer lowpass filter response, but in this case the Q turns up 
automatically when you change the filter frequency. If you turn up the Q 
Wheel, you get even more Q. (The Q control adds to the Lo and Hi Q settings.)

Add Another Section

11. Select Stage 2 and this time choose EQ as the filter type.

12. Turn the Morph Wheel down (you can leave the Gain Wheel centered).

13. Set the Lo Morph Frequency to the minimum setting.

14. Set the Low Morph Gain to zero. (Alt+click the mouse on the control.)

15. Turn the Morph Wheel to the maximum setting.

16. Set the small Hi Morph controls so that another 
little resonance peak appears next to the one 
from the lowpass filter. The filter response 
display should look something like this:

17. Now play the keyboard and turn the Morph Wheel. The dual resonance 
peaks come in as the filter frequency (morph) is turned up, and they sound 
much more interesting than a simple lowpass.
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18. Go ahead and adjust the controls some more, noting the interaction 
between the Lo/Hi Morph controls and the Morph Wheel. It’s really pretty 
simple. The Morph Wheel interpolates between the Lo and Hi settings of the 
filter section.

19. If you want to control the Morph from the continuous controllers on your 
MIDI keyboard, set the Morph Wheel to its minimum position. This allows 
Controller A to have complete control over the Morph parameter.

(To connect the knobs on your MIDI keyboard to control the Emulator X or 
Proteus X, see “Assigning Continuous Controllers” on page 13.)

Add Another Section

20. When you’re ready go ahead and add yet another filter section. You’re on 
your own now so choose any filter type you want. Using just three of the six 
sections you can create some truly great sounding filters.

Explore the Morph Designer Templates

21. Right-click anywhere inside the Filter area. A pop-
up list of Templates appears. Click More Templates 
to view the entire list.

22. Click on a Template name to select it, bearing in 
mind that selecting a template wipe out the current 
filter settings.

23. If you want to Save your filter as a template, choose 
Save Filter Template from this list, then name it 
and click OK.

24. There are some really great sounding filters here. 
Examine the settings of the factory templates to 
learn a few more tricks.

� Tip: Every module in the Voice Processing page has 
its own set of Templates. Right-click over each 
module to view the list of saved templates.
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12 Function Generator Applications
The function generators can be used as note-controlled sequencers that start 
and stop as you play the keyboard. In this tutorial, we’ll show you how to setup 
a sequence, re-trigger filter envelope, add synchronized echoes, and combine 
two function generators to create more complex sequences.

� Using the Function Generator as a Sequencer / Arpeggiator

Set up

1. Load the Proteus X Composer bank.

2. Select preset P0289 FP Powerbass by typing the number into the Single 
View number field.

3. Double-click on the preset name. The Preset Globals page opens and FP 
Powerbass will be selected in the Tree.

4. Click on the (+) symbol (or double-click on the preset name in the Tree) to 
show the other editing pages.

5. Click the Voice Processing icon  to open the Voice Processing module.

6. Go to the Patchcord section and click the 19-27 tab. Cord 20 isn’t being 
used, so use it to patch “Func Gen 1 +” to “Pitch” Set the Cord amount to 
100%  (so the grid will play accurate pitches).

7. Now click the Func Gen 1 tab. The screen below appears.

8. Turn on “Snap to Grid” by pressing the Grid button.

9. Select Major Scale as the Grid Type.

Double-click 
here to find it 
in the Tree. 

Trigger & Gate Grid LinesEnd Step Single Step 
Controls

Snap to Grid Grid Type

Click & Drag 
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Modify the Sequence & Play

10. Click in the graphic display and begin horizontally dragging the mouse. 
Notice how the bars snap to the Grid lines.

11. You can change the End Step by dragging the dotted line.

12. Play a key. Play a chord. Play an arpeggio.

Adjust the Amp Envelope

You’ll notice that the sound doesn’t sustain very long. This is because the 
Amplifier envelope doesn’t have any Sustain. Let’s fix that now.

13. Click the Amp Env tab and turn up the Decay 2 Level parameter to 100.

14. Click the Fn Gen 1 tab again and adjust your sequence until you get 
something you like.

15. Click and drag the End Step line to shorten or lengthen the sequence.

Tip: Hold down the Alt Key as you drag across the note display to select 
random values.

16. Change the Step Rate to change the speed of the sequence. The BPM button 
locks the step rate to a note division of the Master Tempo.

Tip: Turn Show All off to zoom in and only display the steps in your sequence.

17. Go ahead and turn BPM on and set the Note Value to 16th notes.

Retriggering the Filter

Now the sequence is sustaining, but it sounds a little dull. We can retrigger the 
filter envelope with the Function Generator to liven things up.

18. Set up Cord 21 to route Func Gen 1 Trigger -> Filter Env Trigger. Set the 
Cord amount to any positive value. 

19. Turn on the Function Generator Trig/Gates for each step 
in the sequence. (Click the little blue squares to turn the gates on or off.)

20. Now the filter will retrigger with each step. Try turning some gates on and 
some off to give accents to certain notes.

Turn up to 100
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21. Try adjusting the Filter Envelope to change the sound. 
Example: Set the Attack 2 Time to 0.05 sec or try increasing the Decay 2 time 
slightly. To Undo: Press Ctrl+Z, repeat as necessary.

Echo, Echo, Echo...

Adding synchronized echoes is easy since the Function Generator is in BPM 
mode.

22. Click the Emulator X or Proteus X bank icon above 
the Tree. The Multisetup page appears.

23. Click the Aux FX 2 Tab to reveal that the BPM Delay is assigned to the Aux 2 
Bus. This is handy. Now all we have to do is turn up the FX amount.

24. Turn up the Aux FX 2 Amount and play the keyboard. Notice how the 
echoes are synchronized. This is because both the Function Generator and 
the Delay (BPM) are synchronized to the Master Tempo.

25. Change the Tempo now. Everything is locked.

Tip: If the Tempo control is locked, go to Options, Preferences, MIDI and un-
check External Tempo Source.

26. Feel free to modify the Delay (BPM) settings. You can add Reverb by turning 
up the Aux 1 amount.

Aux FX 2

Aux FX 2 Amount
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More Fun..ctions

Now we’ll add another Function Generator to add complexity to the sequence.

27. Go back to the Voice Processing page and click the Func Gen 2 tab.

28. Turn BPM on and set the Step Rate to 1/2.

29. Set up Cord 22 to route Func Gen 2 + to Filter Frequency. Set the Cord 
amount to 50%-100%. 

30. Adjust the Function Generator values and length any way you want. You 
have to re-key the keyboard to hear your changes.

We’ve only scratched the surface of what you can do with the Function 
Generators. See the Voice Processing chapter in your reference manual for all 
the gory details.

More Function Generator Ideas

� Speed Control - You can slow down or speed 
up certain notes by routing the Function 
Generator Gate back to control its own Rate. 
Positive Cord values speed up the gated notes; 
negative Cord values slow down gated notes.

� Glide Control - Only notes that 
have the Gate turned on will glide 
using this patch. This technique 
works well for all kinds of music 
including synth bass lines and 
adds another element of interest 
to the sound.

� Rests and Accents - You 
can insert rests and accents 
onto specific notes using 
this simple patch. To make 
a rest, set the amp cord 
amount negative (turning 
the amp off). 
For an accented note, set 
the cord amount positive 
(making the amp louder). 

Function
Generator

Gate
Out

Rate
In

Function
Generator

Lag
Processor Pitch

Gate
Out

8%

Initial Lag = 0

Function
Generator

Samples Amp

Vol

Pitch

Gate

+ Out

Z-Plane
Filter

Negative Amount = Rest
Positive Amount = Accent
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� Two-Speed Sequence - This sequence 
changes rate every other time it plays 
through. The flip-flop sets and resets 
every other time it is pulsed with the 
function generator gate. The Cord 
amount from the flip-flop controls the 
amount of speed variation.
(Note: The -DC Cord is necessary because 
the flip-flop input needs to go positive from a 
negative value.)

� Multi-Speed Sequence - If you want 
to control the timing for each step in 
a sequence, two function generators 
can be used. Function Generator 1 
controls the pitch and Function 
Generator 2 controls the length of 
each note.

Two function generators will remain 
in sync if their initial rate, length and 
direction are the same, and if the 
modulation is identical for both.

� Sample Re-triggering - The Trigger Out of the 
Function Generator is ideal for re-triggering 
samples. In fact, the trigger out can be used just 
for sample re-triggering without using any pitch 
control. Use Sample Retrigger (-) to trigger on the 
note. 
(Remember, samples to be retriggered MUST 
have a loop.)

Function
Generator

Flip
Flop

Pitch

Gate
Out

Rate
In

DC
-1%

+10%

Adjust to Taste

Function
Generator

1

Function
Generator

2

Rate

Rate

Amounts
must be
Identical

Initial Rate,
Length & Direction
must be Identical

for both.

Function
Generator

Trigger

Sample
Retrigger (-)

Pitch
+ Out
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This chapter is packed with useful tip, tricks and other useful information. Any user, from 
novice to professional sound developer, will be able to find at least one or two new tricks 
here. 

If you don’t believe us, just browse through the first lesson and see if you don’t learn 
something. Some of these tips can improve your samples with a click of a single button. 
(See “Turn Classic Response Off” on page 55.) Others features are “hidden in plain sight,” 
but knowing about them will definitely make your life easier and will make programming 
a lot more fun.
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13 Some Things You May Not Know
Here’s a list of little tricks that will make your life much easier—features hidden 
in plain sight. These tips were all compiled from the Emulator X and Proteus X 
pdf manuals, but here they are in one convenient place.

General Navigation

Browsing Presets
Place the focus on the preset number then use the Up/Down Arrows to 
increment/decrement the presets.

Select a Preset from the Tree
Drag and drop a preset from the tree into the single view screen to select it.

Finding Presets of a Certain Type

1. Press the Type button.

2. Select Category.

3. Inc/Dec only through Presets in the selected category.

Jump to a Preset in the Tree
To find a preset in the Tree after selecting it in the single or multi-view, click the 
Voice Processing shortcut in the Toolbars  or press Alt+P. You can also 
simply double-click the preset name.

Decrement

Increment

2. Category

 1. Type3. Inc/Dec
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Type Preset Names in the Tree
You can type the name of the preset you’re looking for in the Tree to find it.

Knob, Slider and Wheel Shortcuts
First place the cursor over the knob, slider or wheel ...

� Use Up/Down Arrows to inc/dec value

� Use the Page Up & Page Down keys increment or decrement by a larger 
amount.

� Use the Roller on a roller-type mouse to increment or decrement the value.

� Center Control (Pan, etc.) Alt + Click
(Number key 5 also centers a control when Num Lock is off)

� Minimum Setting - Home

� Maximum Setting - End

Move the Cursor from the Computer Keyboard

� Press the Tab key to move the cursor to the next field.

� Press Shift+Tab to move the cursor to the previous field.

Tree Shortcuts
Expand Folder or Node ..........................  Ctrl + R Arrow

Collapse Folder or Node ........................  Ctrl + Left Arrow

Move Up Through Items ........................  Up Arrow

Move Down Through Items...................  Down Arrow

Other Shortcuts
Go to Preset Globals View..............  Alt + G

Go to Voice/Zones View ................  Alt + V

Go to Links View ............................  Alt + L

Go to Voice Processing View.......... Alt + P
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Voices & Zones

Multiple Selection
Multiple selection works for any Voices and Zones operation. Select multiple 
voices, then change a parameter on all of them.

Example: To Mute or Solo Multiple Voices

1. Select the desired voices (Shift or Ctrl-click), then press the Mute or Solo 
buttons at the bottom of the page.

2. To quickly remove all solos and mutes, select Clear All Solos and Mutes 
from the Preset menu.

Voice Processing

Voice Processing Template
You can save the entire Voice Processing window as a template.

1. Set the voice parameters the way you want.

2. Select Voice Processing Templates from the Voice Processing menu.

Function Generator Key Tricks
Ctrl Key ..... Constrains to vertical dragging only. Useful for setting levels.

Shift Key ... All levels are set to the same value, resulting in a horizontal line. 
This also works for the trigger outputs, turning them on or off.

Alt Key....... Values are randomized when this key is held down while dragging. 
This also works for the trigger outputs.

To Create a standard ADSR Envelope
Set the “2” levels the same as the “1” levels and set all the “2” rates to 0.

Change the Action of the Rotary Knobs
If you don’t like the action of the Rotary knobs in the application, try changing 
the response.

1. Select Options from the Toolbar, then select 
Preferences. 

2. Choose the Other Settings tab.

3. Select Rotary, Horizontal or Vertical tracking.

4. Click OK.
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Turn Classic Response Off
TRY THIS! The Classic Response button, located in the Amplifier section of the 
Voice Processing page, allows presets created for the Emulator IV to sound the 
same on the Emulator X and Proteus X. However, the amplifier response on the 
Emulator X/Proteus X has been vastly improved. Turn Classic Response OFF for 
more natural volume response from envelopes and other controls. 

Other Tricks

Capture MIDI Controllers
You can capture the state of all your MIDI input device’s MIDI controllers, and 
place the settings in the Initial Controllers section of the Preset.

1. Go to the Preset Globals window for the preset you want to apply your 
current MIDI state.

2. Make any desired changes to any MIDI controllers on your MIDI input 
device, or in the Multisetup window. (You have to turn each knob you wish 
to save.)

3. From the Preset menu, select Capture MIDI Controllers.

4. To keep these settings, you can Save the Preset.

Import .Wav or .AIFF
Drag & Drop the file over the Emulator/Proteus Icon above the Tree.

Build a New Bank
1. Select the System tab of the Tree.

2. Find the desired bank of material on your hard disk.

3. Open the bank, then open the Presets folder.

4. Audition presets by Right-clicking.

5. Drag & Drop presets over Emulator/Proteus Icon above the Tree.

Floating Keyboard Velocity

The pop-up floating keyboard  normally outputs a velocity of 64, but it can 
also output two other velocity values.

1. Hold Ctrl and play the mini keyboard for a velocity of 10.

2. Play the mini keyboard while holding Shift for a velocity of 127.
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14 Find that Voice using Intelliedit
This slightly hidden feature makes it easy to find out which voices are assigned 
to which keys and also allows you to edit key ranges using the keyboard.

First, make sure Intelliedit is enabled and set to the same MIDI port your 
keyboard is using (Options, Preferences, MIDI).

� To Find out which Voices are Assigned to a Key:
1. Go to the Voices & Zones page.

1. Press and hold Ctrl+Alt on your computer keyboard.

2. Play a key on your MIDI keyboard. The voices assigned to that key will be 
highlighted in red.

3. Play the key again. If multiple voices are assigned to the key, they will be 
highlighted with repeated pressings of the same key.

� To Select a Key Range using Intelliedit:
1. In a Voices and Zones page such as “Key Window”, position the cursor 

inside one of the Key Range fields (Low or High).

2. Press and hold Ctrl+Alt on your computer keyboard.

3. Play a key on your MIDI keyboard. The key range will be edited.

4. To select multiple voices you must use the Group feature.
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15 Streamline Your Banks
Many people use the Proteus X and Emulator X like a ROM-pler with one huge 
bank containing hundreds of presets. This is certainly a valid way to use the 
software and one that we’ve promoted by shipping banks such as the Proteus X 
Composer. However, loading and saving large banks takes time, which can be 
annoying when you’re trying to get work done. This method is also wasteful of 
system memory since every sample has to have its pre-roll loaded into RAM.

The alternate “sampler” approach consists of auditioning and merging only the 
sounds you need for a project. This method is great for keeping load and save 
times short and doesn’t waste memory, but is somewhat less convenient than 
having everything on-line all the time.

Here’s a way that you can have the best of both worlds. It works like this. When 
composing your song, you load the big ROM-pler bank, then create your Multi-
setup with the presets you need for the song. When the basic song tracks are 
laid down, you can Export the Multisetup. This creates a new bank containing 
ONLY the Presets assigned in the Multisetup. Now you have a nice small bank 
to work with, but you began with all the sounds in the bank at your disposal. If 
you need more presets, simply audition them from the hard disk and load as 
needed.

� Export the Multisetup:
1. Load the large bank of your choice, which will serve as your sound palette.

2. Assign the sounds you want on each MIDI channel in the Multisetup.

3. When you’re ready to streamline, select Export... from the Multisetup 
menu. A new bank will be created containing only the presets and samples 
needed for your project.
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16 Channel Conservation using the Poly Key Groups
If you watch the channel meter at the bottom of the screen while playing the 
same chord over and over, you’ll notice that a lot of channels are being 
assigned to play that one chord. The Poly Key Group feature places a fixed limit 
on the number of voice channels that can be played by a single keyboard key.

The Poly Key Group feature is designed for building more efficient presets from 
the ground up, but if you have an existing preset which seems to be consuming 
too much polyphony, you can try this feature which will free up voice 
polyphony in most cases.

� To Conserve Voice Channels using Poly Key Groups:
1. Select the preset and Duplicate it.

2. Using the Copy, go to Voices and Zones and Select All.

3. Go to Voice Processing and set the Assign Group to Poly Key 2A (or Poly 
Key 1A).

4. Play the preset—if it sounds too dry— change the setting to Poly Key 3A.

5. Go to the original preset and play C3 over and over while watching the 
voice display at the bottom of the screen.

6. Do the same with your new preset to see the polyphony savings and make 
sure that you haven’t altered the sound of the preset in a negative way. 
Experiment!

7. Save the Bank.
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17 Preset and Sample Categories
Organizing your sound library is probably one of the most important things 
you can do to improve your productivity. Being able to find just the right sound 
when you need it will help keep you in the creative zone. As your sound library 
grows, it will become harder and harder to find the right sound. Fortunately, 
the Emulator X and Proteus X contain a built-in librarian and category system.

Although the E-MU factory libraries are already categorized, you may want to 
use your own category system that better suits your needs and work methods. 
With this tip, we’ll show you how to change the categories of your Presets and 
Samples quickly and easily.

� To Change the Category of a Group of Presets or Samples:
1. Load the bank of presets you wish to modify.

2. Click on the Presets folder in the Tree. The complete list of presets is shown 
in the main display area.

3. The View buttons in the toolbar allow you to 
display the item in the following ways: Large 
Icons, Small Icons, List View, or Details. If not 
already selected, choose Details to view the 
Preset Categories.

4. Suppose you wanted to rename the category of 
the Keyboard 1 presets to Piano? First, select the presets by clicking and 
dragging a selection box around them.

Large 
Icons

Small 
Icons

List 
View

Details

Click & Drag
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5. Right-click over the area highlighted in blue. 
The pop-up menu shown at right appears.

6. Select Category and the category selection 
dialog box appears. Select the desired 
category from the list or type in a new 
category name.

7. Click OK. The selected presets now belong to the new category.

8. The Category buttons at the top of the window allows you to sort the 
presets. Click on the Category name to sort alphabetically by the category 
names.

9. Save the Bank. Otherwise, your work will be lost.

Change the Category of Samples

10. Changing the category of samples works exactly the same way except that 
you select the Samples folder to view the sample list in the main section 
area.

Organize Your Sounds

You probably have a pretty good idea about the best way to organize your 
library. The category system can be a really useful feature if you put it to work 
for you.

Sort by Category
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18 Using an External Editor
When editing your audio samples, you have the choice of using the sample 
editor built-in to the Emulator X or using a third party sample editor such as 
Steinberg Wavelab, or Sony Sound Forge. While the Emulator sample editor is 
perfect for quick editing, looping and its unique DSP, you may want to use an 
external editor to make use of VST plug-ins and other processing.

It’s simple to invoke the sample editor of your choice from the sample editor 
window. The external editor opens with the current sample loaded and after 
editing, the sample is automatically returned to the Emulator X sample editor 
window.

� To Set Up and Use an External Sample Editor:

Choose the Editor Path

1. From the Options menu in Emulator X, choose Preferences.

2. Click the Other Settings tab.

3. Click on the box to the right of the External Audio Editor field to browse 
for your Wave editor. The Locate Audio Editor dialog box appears.

4. Locate the sample editor (.exe) you wish to use and click Open.

5. Click OK to save the preferences.

Invoke the External Sample Editor

The External Sample Editor can only be invoked from the Sample Edit menu. 
With a sample displayed in the Sample Edit menu, do one of the following:

� Click the icon in the Sample Edit Toolbar.

� Select External Edit from the Sample Edit menu pull-down.

� Hit Ctrl+E on your computer keyboard.

Click Here to Select a Wave Editor
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� Try it out
1. Open any bank.

2. Select a sample from the samples folder in the Tree. The Sample Editor page 
appears.

3. Click the icon in the toolbar.

� If this icon isn’t visible, select 
Toolbars, from the View menu and 
check the Sample Edit box.

4. The External Editor you selected 
launches with the current sample open.

5. Edit the sample using the external 
editor. When finished, click the close 
box  to exit the editor application.

6. The external editor asks you if you wish to Save. Choose Yes. 

7. The external editor closes and the edited sample is returned to the 
Emulator X sample editor.

8. That’s it!
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19 Customizing a Drum Kit
When using the factory drum kit presets, you might find a kit you really like, 
except for a maybe one of two of the sounds. No problemo. Using either the 
Emulator X or Proteus X it’s super easy to create your own custom drum set.

� To Customize a Drum Preset:
1. Load the Bank containing the drum kit you want to modify. For the 

purposes of this example, we’ll load the Proteus X Composer bank.

2. Open Kit1 (preset 009) from the Tree and select the Voices & Zones page.

3. Select the KEY WIN tab to show the key mapping of each drum.

4. On your MIDI keyboard, play the key of the drum you want to replace while 
holding down Ctrl+Alt on your computer keyboard.

5. The voice you played will be highlighted in red in the Key Window. For this 
example, let’s swap out the 908 Kick1 on Voice 1.

� Note: If the voice you played does NOT highlight, make sure Intelliedit is 
enabled and set to the same MIDI port your keyboard is using (Options, 
Preferences, MIDI).

Method 1: Inc/Dec

6. With the Voice highlighted as in the screen above, you can increment or 
decrement through the samples using the Up/Down keys on your computer 
keyboard. 

7. Play your MIDI keyboard to hear the sounds. Since the kick drums are 
grouped together in the list, you can audition them all quickly.
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Method 2: Picking Samples from the Tree

8. Go to the Samples folder in the Tree to find a better kick drum. In this 
bank, the kicks go from S1545 to S1599. 

9. To Audition, select the sound in the Tree, Right-click the mouse and select 
Audition

� Note: You can also select the sample, then hit the space-bar to audition, but 
this method jumps you to the Sample Editor and loses your place in the 
Voices & Zones window.)

10. When you find the drum you want in the Tree, click and drag the sample 
over the sample name in the Key Window. Release the mouse button and 
the new sample replaces the old one.

Method 3: Search your Entire Library for Drums

11. Select the Library tab below the Tree.

12. Type “Kick” in the Filter By Name box, then click Search.

13. Audition the sounds by selecting them and hitting the Space-Bar.

14. When you find the sound you want, click the Voices & Zones icon  in the 
Toolbar. The Voices and Zones page pops back into view.

15. Click and drag the sample over the sample, as shown in the screen above 
to replace it.

Continue to Customize your Drum Kit

16. Save the Bank. Choose Save As... if you want to keep the original bank 
intact, or Save to overwrite the existing bank with your new drum kit.

� Tip: Use this technique to create a custom General MIDI sound set.
64 EMU Systems, Inc.



Intermediate Lessons
20   Double Drum Speed using the “Up” Layer
20 Double Drum Speed using the “Up” Layer
When sequencing drums, it can be difficult to play the keyboard fast enough 
for the part. This handy little trick makes is twice as easy by placing a copy of 
the voice on a key-up layer. This way you get two drum hits on each key press, 
making it easy to do fast runs and drum rolls.

� To Double a Drum on the Up Layer:
1. Choose the drum you wish to double. In this example we’ll use P0009-Kit1 

from the Proteus X Composer bank.

2. Open Kit1 from the Tree and select the Voices & Zones page.

3. In this example we’ll double Voice 3- Boxy Snare 1. Select Voice 3 - Boxy 
Snare 1 so that it is outlined in red.

� To find out which voice you are playing on the keyboard, press and hold 
Ctrl+Alt then play the keyboard key. The voice you are playing will be 
highlighted in red on the Voices & Zones page. (Note: Intelliedit must be 
enabled in the Options, Preferences menu.)

Duplicate the Voice

4. Select Copy from the Edit menu or by pressing Ctrl+C.

5. Select Paste from the Edit menu or by pressing Ctrl+V. The following popup 
dialog box appears:

6. Select “After the end of the selection”, then click OK. Boxy Snare 1 will now 
be duplicated in the voice 4 location.

Program the Voice for Key-up Triggering

7. Select the Voice Processing page from the Tree. Notice that only Voice 4 is 
selected in the Voice Selector.

8. Select Poly Rel Trig/Note Vel (or Poly Rel Trig/Rel Vel if your keyboard supports 
release velocity) key mode. This control causes the voice to trigger on a key-
up instead of a key-down.

9. Play your double-drum on the keyboard (D1).
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21 Creating a Drum Machine using Cubase
Wouldn’t it be nice to have some realistic sounding drums while you jam or lay 
down audio tracks instead of a sterile metronome? The Twistaloop features of 
Proteus X2/Emulator X2 make it easy to create your own drum machine that 
can track tempo changes. (If you’d rather use Sonar, see page 70.)

You can use the TwistaLoop Xperience bank for this example, or alternatively a 
bank containing complete drum parts that can be beat-analyzed. Drum 
patterns are available from a variety of sources on the internet and elsewhere. 
(Note: To use third-party drum loops you’ll need the Beat Analysis features of 
the Emulator X2.)

The basic idea of this tip is to create a sequence that will trigger Emulator X or 
Proteus X at the start of each measure. If the drum track has been beat- 
analyzed, and Twistaloop is on, the drums will lock to the sequence 
independent of tempo.

Create a Drum Trigger Track

1. Open Cubase and create a New Project.

2. Add a MIDI track.

3. Make sure Snap is On.

4. Create a MIDI Data Object by selecting the Draw Tool and clicking once in 
the first measure of the track. You’ll end up with a MIDI data object, which 
looks something like one shown below.

5. Select the Object Selection Tool, then Double-click inside the MIDI data 
object to open the MIDI Key Editor window.

MIDI Data Object

Snap

Draw ToolObject Selection Tool
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6. Select the Draw Tool and draw a note that takes up the entire measure 
(a whole note), as shown above. If the note you drew isn’t exactly one 
whole note, you can edit the length by selecting the Object Select Tool and 
dragging the ends of the note.

7. Select the note you just drew using the Object Select Tool. The note should 
be black.

8. Select Repeat from the File menu and repeat 
the note 50 times or as long as you want the 
song to last. Press OK.

9. Close the Key Editor by clicking on the close 
box.

10. Extend the length of the MIDI Data Object 
by clicking on the box in the lower right and 
then dragging to the right. Keep dragging to 
the end of the MIDI notes.

11. Save the Project.

Open Emulator or Proteus as a Virtual Instrument

12. Select VST Instruments in the Devices menu.

13. Select Emulator X or Proteus X as the Virtual Instrument.

Draw ToolObject Select Tool

Click & Drag

Select EmulatorX2 or ProteusX2

Open Editor
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14. Open the Emulator X or Proteus X by clicking the Editor button.

15. Open the Twista Mania bank from the File menu. If you don’t have the 
Twistaloop Xperience bank, load a bank of drum loops and perform Beat 
Analysis on each sample. See the Emulator X2/Proteus X2 operation manual 
for full details on Twistaloop.

16. Turn Twistaloop Override on, as shown in the screen shot above.

17. The Tempo control should be “greyed-out” as shown in the screen shot 
above. If not, go to Options, Preferences, MIDI, and select External Tempo 
Source. This will allow Cubase to control the Twistaloop tempo.

Set up the Virtual Instrument

18. Turn on Show Inspector  if it’s not already 
on. The track inspector panel (shown at right) 
appears.

19. Select Proteus X or Emulator X as the MIDI 
track output (as shown at right).

20. Make sure the MIDI channel matches the 
channel on Proteus X or Emulator X.

21. Press Play on Cubase. If your MIDI note is in 
the range of C1 to C6, you should now be 
hearing sound.

Turn Twistaloop Override On

MIDI Channel

Tempo

Select
Proteus 
or Emulator
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Change the Drum Pattern

22. Open the Key Editor by double-clicking inside the MIDI object.

23. Turn Autoplay Off. (You may have to expand the Key Editor window to 
see the icon.)

24. Ctrl + Click on the vertical keyboard next to 
your MIDI track as shown at right. The MIDI 
events turn black indicating that they are 
selected.

25. Press Play (space bar) on Cubase and use 
the Up/Down arrow keys on your computer 
keyboard to move the events to different 
MIDI keys. This is how you select different 
drum patterns.

26. Because Twistaloop is on, you can change the tempo and the drums will 
stay in time.

Record an Audio Track

27. When you find a pattern you like, simply add an audio track and start 
recording. It’s much more inspiring to play with a real drum track, rather 
than the click-click of the metronome.

Going Further

If you have drum tracks that are separated into their component parts (bass 
drum, snare, hi-hats, etc.), you can create MIDI tracks for each different part 
and then mix and match parts (i.e. take the bass drum from one pattern and 
combine it with the snare of another).

The Beat Shop, Protean Drums and Xtream Lead-1 sound sets from the E-MU 
library are perfect for this kind of drum part creation. In addition, there are 
many other commercially available drum groove collections which are also 
applicable to this technique.
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22 Creating a Drum Machine using Sonar
This tutorial is a repeat of the previous lesson for the Sonar people out there. It 
shows you one way to use realistic sounding drums as a metronome while 
jamming or laying down basic tracks. The Twistaloop features of Proteus X2/
Emulator X2 make it easy to create your own drum machine that can track 
tempo changes.

You can use the TwistaLoop Xperience bank for this example, or alternatively a 
bank containing complete drum parts that can be beat-analyzed. Excellent 
drum patterns played by professional drummers can be found on the internet 
and elsewhere. (Note: To use third-party drum loops you’ll need the Beat 
Analysis features of the Emulator X2.)

The basic idea of this tip is to create a sequence that will trigger the Emulator or 
Proteus at the start of each measure. If the drum track was beat-analyzed and 
Twistaloop is on, the drums will lock to the sequence independent of tempo.

Create a Drum Trigger Track

1. Open Sonar and create a new Project. The Track View window appears.

2. Select Synth Rack from the View menu.

3. Click on the + symbol and insert the Emulator X or Proteus X as a DXi.

4. A popup dialog box appears as shown below. Click OK.

Insert DXi Instrument
70 EMU Systems, Inc.



Intermediate Lessons
22   Creating a Drum Machine using Sonar
Note: If you get an error message stating that the VSTi could not be inserted, 
you may have to run the Cakewalk VST Adapter. Select and run this 
application from the Windows, Start menu.

5. The ProteusXVSTi or EmulatorXVSTi now appears in the Synth Rack and a 
MIDI track has been added to the Track View window.

6. Click on the Properties button to open Emulator X or Proteus X.

7. Before the Proteus X or Emulator X can play, you must load a bank of 
sounds. Select Open from the File menu on Proteus X or Emulator X.

8. Select Twista Mania or any other bank of drum loops.

Properties Button

Turn TwistaLoop Override On
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9. Turn Twistaloop Override on, as shown in the Proteus screen shot.

10. The Tempo control should be “greyed-out” as shown in the Proteus screen 
shot. If not, go to Options, Preferences, MIDI, and select External Tempo 
Source. This will allow Cubase to control the Twistaloop tempo.

11. Close the Proteus X or Emulator X editor by clicking on the Close box. 

12. Right-click on the MIDI Track that was just added to the Track View. Select 
View and then Piano Roll (or select the track and press Alt+5).

13. The Piano Roll window appears as shown below. Select Whole Note for 
drawing.

Tip: To make Sonar’s Piano Roll match the note settings in Proteus X or 
Emulator X, go to Options, Global, General, and set the Base Octave for 
Pitches to -2.

Right-click Here

Whole Note

Click Here to Draw
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14. Select the Pencil Tool and then click inside the note area to add a whole 
note to the first measure. In the example above we’ve chosen note C4.

15. Click the Select Tool , then click on the whole note you’ve just drawn to 
select it. When selected, it turns a darker shade of grey.

16. Select Copy from the Edit menu. A popup dialog box appears. Press OK.

17. Select Paste from the Edit menu. The following dialog box appears.

18. Change the Starting Time to 2:01:00.

19. Set the number of Repetitions for as many measures as you want the song 
to last, say 100.

20. Press OK. You’ll end up with a very long stream of whole notes, lined-up 
exactly on the bar lines.

21. Save the Project (Ctrl+S).

22. Control-click the Vertical Keyboard note 
where you have placed your line of whole 
notes. This selects all the MIDI events on 
that note. The MIDI events turn dark, 
indicating that they are selected.

23. In Sonar press Play (space bar). The track begins playing.

Change the Drum Pattern

24. Use the Up/Down arrow keys (8 & 2)on the 10-key pad of your computer 
keyboard to move the events to different MIDI keys. This is how you select 
different drum patterns.

25. Because Twistaloop is on, you can change the tempo in Sonar and the 
drums will stay in time. (Make sure “External Tempo Source” is On in 
Proteus X or Emulator X.)
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Record an Audio Track

26. When you find a pattern you like, simply select one of the audio tracks and 
start recording. It’s much more inspiring to play with a real drum track, 
rather than the sound of the metronome.

Going Further

If you have drum tracks that are separated into their component parts (bass 
drum, snare, hi-hats, etc.), you can create MIDI tracks for each different part 
and then mix and match parts (i.e. take the bass drum from one pattern and 
combine it with the snare of another).

The Beat Shop, Protean Drums and Xtream Lead-1 sound sets from the E-MU 
library are perfect for this kind of drum part creation. In addition, many of the 
commercially available drum collections are applicable to this technique.
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23 Using TwistaLoop & the Xploder
For the purpose of this tutorial we’re using the Twista Mania bank as the source 
of drum beats. If you have another drum part you’d rather use, go ahead and 
use it.

Grab a Beat

1. Start by loading the Twista Mania bank.

2. Open the Samples folder and select S001 TL 
Beat 1, the first sample in the list.

3. The Sample Editor window opens with our 
sample displayed.

Clear the Beats

We need to undo the beat analysis so you can do it yourself. If you’re using 
your own drum part, you can skip the next three steps.

4. Notice that the sample has already been Beat-Analyzed. Let’s undo that 
now.

5. Left-click anywhere in the waveform display area.

6. From the Sample Edit menu, select Beats, then Clear Beats. The Beat 
Markers disappear. (If Clear Beats is greyed-out, click in the waveform 
display, then try again.)

7. Let’s clear all the loops from the sample. From the Sample Loop menu, 
select Delete All Loops. OK, now we’re ready to proceed.
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� Analyzing the Beat

8. From the Sample Edit menu, select Beats, 
then Beat Analysis (Ctrl+B). The pop-up 
dialog box shown at the right appears.

9. Beat analysis works best when the Tempo 
Range is somewhat close to the actual 
tempo of the beat you want to analyze. In 
this case, try setting the tempo range 80 to 
130 bpm. Leave the other parameters as 
shown and press OK.

10. The beat and note markers appear. The green diamonds are Beat Markers 
and the red triangles are Note Markers. Beat Analysis looks at your 
sample, and intelligently divides it into beats and notes. Each beat marker is 
assigned a bar and beat number. The first beat of the measure is denoted by 
a red dot in the beat marker.

11. Select a section of the waveform and notice how your selection “snaps” to 
the marker lines. Zoom in on the waveform by clicking on the Horizontal 
Magnification button.

12. Play the selected section by hitting the Space Bar. Hit the space bar again to 
stop playing.

Note Marker Sensitivity

Selection “Snaps” 
to Marker Lines

Horizontal Magnification
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13. You can change the note division of the note markers by changing the Note 
Marker Sensitivity.

14. When the Beats button is on, note markers can be set to actual note 
values. When off, Note Markers are set according to amplitude percentage. 
It’s easier to use actual note values, so leave the Beats button on.

15. Take a closer look at the Beat Markers again and notice that the first beat of 
each measure has a tempo label next to it. The tempo has been calculated 
once per measure. This is the Tempo Granularity and it is important 
because Twistaloop corrects tempo based on these markers.

Changing Tempo Granularity

16. To change the tempo granularity, Right-click on one of the green Beat 
Markers and choose Beat Parameters from the pop-up menu. The 
following dialog box appears.

17. Check the box next to Tempo Granularity Changes Here and set the 
Tempo Granularity to 1 (update on every beat) for the tightest loops. Click 
OK.

Tempo Granularity controls how often an original tempo is calculated. 
Lowering the Tempo Granularity can produce a tighter song, especially if 
you play multiple loops simultaneously. A higher Tempo Granularity, 
however, can produce a more realistic, less robotic sounding loop.

18. Notice that the tempo information now appears on each and every Beat 
Marker.

Set Tempo Granularity to 
1 beat for tighter loops.
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� Creating Multiple Loops in the Sample
After beat analysis, it’s easy to select individual sections to create loops.

1. Select the first two beats by clicking and dragging over the section.

2. From the Sample Loop menu, select Make Loop From Selection. Yellow 
loop markers now appear at the beginning and end points of your selection.

3. Press the Space Bar to play the sample and select another section to loop. 
You can select loops while playing.

4. When you find another loop you like (and without stopping) make another 
one by clicking Ctrl+Shift+L. This is a quicker way to define loops.

5. Make a few more loops. Try changing the Note Marker Sensitivity if you 
want to snap to a smaller loop. Loops can even be inside of other loops.

6. Check out the Loop Number field above the waveform display. Changing 
the loop number highlights the loop markers of that loop.

 Selecting Sections for Sample Editing

7. The beat and note markers are also extremely handy for selecting sections to 
digitally process. Set the Note Sensitivity to 1/8 notes and select a small 
section of the beat (highlight in red).

8. From the Sample Edit menu, select Reverse.

9. Press the Play from Start button  and listen. Beat analysis makes it a snap 
to digitally process specific hits or sections.

Loop Number

Loop

Markers
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10. From the Edit menu, select Undo Reverse. Now your beat is back to 
normal.

11. Now try out another digital process. Select Adjust Gain from the Sample 
Edit menu and set the gain to -6dB. Press OK.

12. Press the Play from Start button  and listen again. You can see how easy 
it is to modify and reshape the beat.

� Note: The Sample Edit processes are “destructive” because they modify the 
actual sample data when you save the bank. It’s usually a good idea to 
Duplicate the sample before performing Sample Editing functions to 
preserve the original sample.

� Note #2: The FG 1 and FG 2 controllers in the Twista Mania bank allow you 
to non-destructively alter the beat using the Function Generators. To find out 
how it’s done, examine the Function Generators and the associated Cords.

� Controlling the Multiple Loops
Earlier, you defined several loops. Now you’ll learn how to select your loops 
using a MIDI controller.

Set up a New Preset

1. Let’s start fresh with a new preset. Click the 
Preset folder in the Tree and select New Preset 
(Ctrl + W) from the Presets menu. A new preset 
appears in the Tree.

2. Click on Voices and Zones. The Voices and 
Zones page appears.

3. Select S001 TL beat 1, the first sample in the Tree, then drag and drop it 
over the C3 key on the keyboard at the bottom of the window.

4. A new voice named S001 TL beat 1 appears in the window on note C3.

5. Select the Key Win tab. This window graphically displays the current sample 
to keyboard mapping. The display should look something like this. The red 
bars show the original keys.

Drag and Drop

Original Keys

Empty Voice
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6. Notice that the top voice has no sample. This empty voice was created when 
you created the Preset. We won’t need this voice and can get rid of it. 
Select the empty voice by clicking on it. It becomes highlighted in red. Press 
the Delete key on your keyboard to delete it.

7. Play C3 on your keyboard to verify that the drum beat plays.

Assign the Loop Controller

8. Select the Voice Processing page by clicking the Voice Processing icon in the 
Tree.  The Voice Processing page appears.

9. Normally we would have to select the Voice using the Voice Selector, but in 
this case we only have one voice, so we can skip this step.

10. Set Loop (n) to 1. Select Start At Loop.

The Start At Loop button determines whether playback begins from the 
beginning of the sample, or from the start point of the loop. You should 
keep the Loop (n) knob set to 1. This allows you access to all your loops. 
Use the Cord’s Source to control the initial loop.

11. Set up Cord 9 as shown with MIDI A as the source 
and Loop Select (Jump) as the destination.

12. Set the Cord Amount to +100.

Start 
Loop

Loop Select

Voice 
Select
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13. When you play back the sample by playing C3, looping behaves as follows: 
If you don’t touch the MIDI A controller on your keyboard, playback begins 
at the start point of Loop 1. Once you reach the end of Loop 1, Loop 1 repeats 
until you move the MIDI A, or release the note.

14. When you move the MIDI A controller, playback 
continues on the currently playing loop until it 
finishes, then it JUMPS to the loop selected by the 
MIDI A controller.

The knob range is automatically divided according to 
how many loops you have set. If you had six loops 
defined, the loops would be selected according to the 
knob position shown at right.

15. MIDI A is just one way you can select loops. Any of the Cord sources can be 
assigned to control loops. You can also assign a range of keyboard keys to 
select loops (see the Emulator X2 pdf manual for details).

Labil yur Nobs!

16. We might as well label the Loop knob for future reference. Click on your 
new Preset in the Tree.  The Preset Globals page appears.

17. Type into the Label field for CTRL A. Now Controller 
A will be labelled in the main screen.

Incidentally, you can also select which loop starts 
when the preset is selected by setting an Initial Controller Amount here. If 
you want Loop 1 selected first, leave the Initial Controller Amount Off.

� Creating Region Loops
Another way you can use a sample that contains bar, beat, and loop infor-
mation, is with the Regions page in the Voices and Zones window. You can use 
the same sample for multiple voices, and select different beats or bars for each 
voice. This allows you to map different beats or bars from a single sample to 
different keys. The original sample is not altered.

As with loops defined in the Sample Edit window, you can lock your region-
based forward loops to a clock source and modulate them using Tempo knobs.

Create a New Preset

1. Make a new preset as you did before by clicking the Presets folder in the 
Sampler tree to the left, and selecting New Preset from the Preset menu.

2. In the new preset, select Voices and Zones. There should be one voice 
already there.

3. In the sampler Tree to the left, expand the Samples folder (but don’t click 
any samples).

Loop 4

Loop 6
Loop 5

Loop 3

Lo
op

 2
Lo

op
 1
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4. Click and hold sample S001 TL beat 1. While still holding down the mouse 
button, drag the sample to C3 on the keyboard at the bottom of the Voices 
and Zones window. This creates a new voice, with the sample you selected 
mapped to C3.

5. Repeat step 5, this time dragging S001 TL beat 1 to D3.

6. Repeat step 5 again, this time dragging S001 TL beat 1 to E3.

7. Delete the empty voice that was initially in the preset by right-clicking the 
voice and hitting the Delete key on your computer keyboard.

Setting a Voice Region

8. Select the voice assigned to C3 by clicking on it. The voice becomes 
highlighted in red and the keyboard at the bottom of the shows C3 in blue.

9. Click the Region tab. The Region Editor display appears at the bottom of the 
page.

10. Take a closer look at the waveform display and note that it has the same 
beat markers, note markers and beat sensitivity controls. Dragging your 
cursor over the waveform display will cause the select to snap to beat and 
note markers.

Key Assignment of Selected Voice

Selected
Voice

Loop 
Direction 
Control 
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11. Choose 1/8 Note Sensitivity and click the  Horizontal Magnification 
button twice.

12. Select Forward Loop  using the Loop Direction Control and play the 
C key.

13. Make a selection for your loop by clicking in the display. Adjust the loop 
until you find one you like.

Set Another Voice Region

14. Select the voice assigned to D3 by clicking on it. The voice becomes 
highlighted in red and the keyboard at the bottom of the shows D3 in blue.

15. Select Forward Loop and play the D3 key.

16. Select another loop by clicking in the display. Now you have two loops you 
can play with C and D.

17. Select the voice assigned to E3.

18. Select Backward Loop  and play the D3 key.

19. Set another loop. Now you have loops on C, D and E.

Turn TwistaLoop On

20. The three loops you created may sound good together, but they aren’t really 
synchronized. For that, you have to turn TwistaLoop On.

21. Click the Emulator X icon above the Tree. 
The main Multisetup page appears.

22. Turn TwistaLoop Override On at the 
bottom of the page. Now your loops will 
lock together and lock to the master tempo. 

23. Try changing the Tempo and note that your loops lock to the new tempo. 
(Tempo is located above and to the right of the TwistaLoop Override.) If the 
tempo knob is “greyed-out” uncheck “External Tempo Source” in the MIDI 
Preferences menu. (Options, Preferences, MIDI tab).

� Keep in mind that all the other Tabs in the Voices and Zones window are 
still active and can be used to select voices. In fact ALL the Emulator X 
features (such as the filters and synth parameters) are active and can be 
combined with Twista Loop any way you can imagine.

Horizontal Zoom Controls
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� Region Xplode
You’ve just created three voice regions. Now we’re going to show you how to 
create new voice regions automatically using the Region Xplode feature.

1. Select one of the forward looped voices, then select another section of the 
wave from the Region Editor. Region Xplode creates new voices based on 
the setting of the Sensitivity control. In the example below a new voice will 
be created for every eighth note in the selection.

2. Set the Sensitivity control for the note division you want.

3. From the Preset menu, select Region Xplode. A pop-up dialog box appears.

4. Set the Start key to C4 and leave the Placement field set to “White Keys.” 
Turn Export MIDI File Off if it’s on. Press OK.

5. A bunch of new voices suddenly appear. That was pretty easy. You can play 
through the sample by playing up the keyboard.

� Important Point: In order for TwistaLoops to synchronize, the loops must 
be located between Beat Markers (not note markers). TwistaLoop must also 
be turned on. You can verify this for yourself by simultaneously hitting two 
keys.

6. Now try moving the Pitch Wheel of your keyboard while you play a loop. 
Notice how the pitch changes, but the beat stays constant. (If it doesn’t, 
TwistaLoop is off.)

7. You can also change the pitch of the sample by changing the Original Key 
in the Voices and Zones page. As before, the beat timing stays constant.

Hopefully you now have a pretty good idea of what TwistaLoop is all about. If 
you need more information, there’s an entire chapter devoted to TwistaLoop in 
the Emulator X Operation Manual.
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The advent of sampling and sampled drum machines allowed non-drummers 
to create their own drum tracks. But even though early drum machines used 
actual digital recordings as their sound source, you could still tell that it was a 
machine and not a real drummer playing.

Part of this is probably due to overuse of the Auto Correction feature, and that a 
real drummer plays, well, like a real drummer. But a big part of the problem 
stems from the fact that the human ear is extremely sensitive and can discern 
that the same sample is being played over and over. Your brain gets bored 
easily.

The Cycle Group feature on the Emulator X is designed to correct this short-
coming. Instead of playing one sample over and over, the cycle group feature 
allows 2, 3 or 4 samples to be cycled, or if you so desire, played randomly. As it 
turns out, this little juggling act is enough to fool the ear.

Other slight variations in the sound can also work wonders. Drum 
programmers commonly route: velocity-to-volume, velocity-to-filter, or 
velocity-to-sample start to make each note unique.

The use of Cycle Groups is not limited to drums and percussion. Cycle Groups 
work great with bowed strings, so that you can alternate between up and down 
bowing. Most instruments will benefit from the variation that Cycle Groups 
provide. However it’s much more difficult to match the tonal properties of 
pitched instruments to create a realistic sounding instrument model.

In this example, we’ll use just two snare drum samples to illustrate the point. If 
you want the ultimate drum set, you’ll want to sample two to four similar-
sounding hits at several strike velocities. Some keys in our Protean Drums 
bank have eight or more samples mapped to create a super-realistic acoustic kit.

� How to Use Cycle Groups

Locate Samples and Load them into the Bank

1. Make sure you have either the Proteus Composer or Proteus X Composer 
bank on your hard disk.

2. Let’s start with a clean slate. Select New from the File menu.

3. Click the System Tab at the bottom of the Tree.

4. Locate the Proteus X Composer bank on your hard disk. The default 
location for sound banks is: “Program Files\Creative Professional\
Emulator X\Production Sound Banks”.
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5. Drill down into the Tree until you find the 
Proteus X Composer Bank. Open the Bank 
Icon.

6. Click on the Sample Folder, highlighting it 
as shown below.

The entire list of Proteus X Composer 
samples appears in the large pane to the 
right of the Tree.

7. For this lesson, we’re interested in two 
particular samples: 1628-Snare 2, and 
1630-Snare Tail.

8. The samples may be listed in alphabetical 
order. To sort by ID number, click on the 
ID heading above the list.

9. Drag and Drop the Snare 2 and Snare Tail samples over the Emulator X 
icon above the Tree. The samples have now been added to the empty bank.

10. Click the Sampler Tab at the bottom of the Tree. Now you’re back in 
Emulator X territory.

Build a Preset

11. Click on the Presets folder  in the Tree to give it the focus.

12. From the Presets menu, select New Preset (Ctrl+W). Note that this option 
was not available until you selected the Presets folder. A new preset appears. 

13. Click the Voices and Zones icon in the Tree. The Voices 
and Zones page appears in the right pane.

14. Open the Samples folder by clicking on the plus symbol  next to the 
folder. The two samples you added to the bank should be there.

Bank 
Icon
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15. Drag and Drop the first sample right over the top of the empty name field 
of the voice that was created with the preset.

Don’t let go of the mouse button before dropping the sample or the Sample 
Edit screen will appear. (If it does, simply click on the Voices and Zones icon to 
try again.)

16. Drag and Drop the second sample anywhere BELOW the name field of 
voice one. This creates a new voice. If you drop a sample on the name field, 
it replaces the sample in that voice.

Assigning the Voices to Cycle Groups

17. Click the CC WIN 1 tab above the Voices and Zone page.

18. Select Cycle 2 (Key) from the Source menu for both voices as shown above.

19. Next, grab the Window Range Bars and adjust as shown below so that the 
range of one voice encompasses the value of 127 and the other voice 
encompasses the value of 0.

� An Explanation: Cycle 2 (Key) generates an alternating value of 0, then 127, 
then 0 and so on, every time the same key is pressed. If a Voice’s Window 
Range contains the value generated by the Cycle 2 generator (0 or 127). 
then that voice will sound. None of the other values matter.

Name Field

Drop Here

Select “Cycle 2 (Key)”
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20. Repeatedly play the same key on the keyboard. You should hear the two 
snare drums alternating with each key press.

These two drums were chosen for this example because they are fairly close 
in timbre, but they’re probably not even from the same drum set! When 
you sample your own drums, the effect is much more believable. Check out 
the Protean Drums bank if you want proof.

Cycle 2 (Channel)

21. Change the Source of both voices to Cycle 2 (Channel) and play the 
keyboard. Do you notice the difference? The drums now alternate with ANY 
key press. Before they only alternated if you played the same key.

Randomize the Drums

22. Now change the Window Range bars so that each voice covers half of the 
range, as shown below. One voice’s range extends from 0-63 and the other 
from 64-127. It doesn’t matter which is which.

23. Change the Source of both voices to Random.

� An Explanation: A new random number between 0 and 127 will be 
generated whenever you press a key. If a voice contains that number in its 
range it will play, if it doesn’t contain the random number, then it won’t 
play.

24. Play the keyboard. The two snares alternate randomly.

25. If you change the ratio of the Window 
Range bars as shown at right, Voice 2 
has more chance of being selected.

� Of course you can combine the Cycle Groups with other conditions such as 
velocity. As an example, you could have one particular sample that always 
plays when the key velocity is greater than 90. Otherwise the three other 
(lower velocity) voices cycle. How? In the VELWIN, simply set the three 
cycling voices to sound with velocities of 0-89 and the other voice to sound 
with velocities of 90 and above.

� There’s no rule that says that the cycling voices have to be the same sound. 
You could create an entire keyboard full of crazy random keys if you 
wanted. Hmm? That experimental music show is coming up....

� Try routing one of the MIDI A-P controllers to your CC Window. Now the 
voices will be selected by the setting of a knob. (Wherever the knob is set at 
note-on time.)
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Special effects are the spices of your music, and also happen to be a special forte of 
Emulator X and Proteus X. We begin this chapter with the obligatory random computer 
effect, then veer off through a panoply of wonderful and fantastic effects. 

We all know that a little bit of flanging or echo can make a sound a lot more interesting. 
Well, how about effects that are controlled by the key velocity of pressure? The voice-
controlled effects of the Emulator X and Proteus X provide a new level of musical control 
that has yet to be fully explored.

Special effect sounds can also be powerful idea generators when composing, or when you 
get stuck in a creative rut. Most of all they’re fun and can add that extra bit of polish to 
your song.
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25 Random Sample/Hold Effect & the Quantizer
One of the classic synthesizer effects involves controlling either the pitch or the 
filter cutoff with a random stepped source. Traditionally this was done with 
Noise Generator routed through a Sample and Hold module and then to pitch or 
filter cutoff.

The Emulator X/Proteus X can easily create this effect using the Random LFO 
waveshape.

� Create a Random S/H Effect:
1. For this example, let’s start with a synthesizer preset from the Proteus 

Composer bank - P0343 Synth 10.

2. Type 343 to the Preset number field in the Single view and press Enter. 

3. To jump right into the Voice Processing Page, press the Voice Processing 
button in the Toolbar. It looks like this:  (This shortcut also jumps you to 
the preset in the Tree.)

4. Select All in the Group field (lower left corner) to select all voices for 
processing.

5. Select the LFO/LAGS tab. The LFO sub-page appears.

6. Change the Shape of LFO 1 to Random.

7. Set the Frequency (FREQ) to about 7.00.
90 EMU Systems, Inc.



Special Effects
25   Random Sample/Hold Effect & the Quantizer
8. Over in the Cords section, change the Amount of Cord 1 to +100.

9. Now just turn up your Mod Wheel and play. The classic S/H sound.

� Route the S/H to Filter Cutoff:
1. Change the destination of Cord 2 to Filter Frequency.

2. Adjust the initial filter frequency. MIDI controller A and the Filter 
Frequency control in the Voice Processing page both affect the initial 
frequency.

3. Adjust the filter Q (resonance) to obtain the classic synthesizer effect.

Reducing Filter Popping

4. The sharp transitions of the LFO may cause the filter to pop, especially with 
high amounts of resonance.

5. Inserting a Lag Processor after the Quantizer will smooth the sharp transi-
tions and reduce the popping. The complete patch is shown in the chart 
below. The new Lag connections are shown in Bold.

6. Adjust the rate of Lag 1 to about 0.5 or 1. This should reduce the filter 
popping to an acceptable level. Large rate values will completely smooth 
the transitions, but will negate the stepping effect that we want.

7. Adjust the filter Frequency and Q settings until you have a sound you like.

8. Try out some of the different filter types.

� Note: Some of the filter types may distort because of their extremely high Q 
values. If you hear distortion, simply reduce the Amplifier Gain (located 
immediately to the right of the Filter Frequency).

Cord # Source Amount Destination

01 Mod Wheel +100 Cord 02 Amt

02 LFO 1 + 0.00 Lag 1 In

21 Lag 1 +100 Filter Frequency
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� Create Sample & Hold Effects with the Quantizer
The quantizer can be used to create complex stepped patterns using LFO waves 
or other modulation sources such as envelope generators. By combining both 
LFOs, then quantizing the sum, interesting S/H style patterns can be easily 
created.

1. First of all change the Shape of LFO 1 to a Sawtooth. Set the FREQ of LFO 1 
to about 1.50 Hz.

2. Next, change the Cord 1 Amount to +50.

3. Set Cord 2 with LFO 1+ as the source and the 
Quantizer as the destination.

4. Select the 19-27 tab on the Cords and set up Cords 19 and 20 as follows:

5. Cord 19:  LFO 2 + to Quantizer with an Amount of +50.
Cord 20:  Quantizer to Pitch with an Amount of +100.

A summary of all the Cords is shown below:

6. Almost finished. Change the Shape of LFO 2 to Sawtooth and set the FREQ 
about 0.30 Hz. Turn Key Sync Off.

7. All set. Now play the keyboard and adjust the Mod Wheel to hear the 
double ascending pattern.

8. Now just play with the various settings of the LFO waveforms, LFO 
frequencies, and Cord amounts for endless pattern variations.

9. Speaking of variations, the LFO Variation control will slightly randomize 
the LFO frequency each time you press a key.

Cord # Source Amount Destination

01 Mod Wheel +50 Cord 02 Amt

02 LFO 1 + 0.00 Quantizer

19 LFO 2 + +50.00 Quantizer

20 Quantizer +100.00 Pitch
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� Background: Quantizer
The quantizer is a modulation processor that turns smoothly changing values 
into discrete steps. But what is it good for?

� Connecting the quantizer between the Mod Wheel and Pitch will give you a 
pitch bender that shifts the pitch by specific amounts.

� The quantizer transforms LFOs and envelopes into stepped shapes which 
can be set to semitone values.

� Aftertouch can be routed through the quantizer in order to obtain specific 
pitches.

� The diagram below shows the quantizer converting a sawtooth waveform 
into a staircase. 

Pitch Amount Chart
In order to obtain specific pitches when routing LFOs, envelopes and 
controllers through the Cords use the following chart.

Change the Modulation Source

10. Try using the Aux Env + instead of the LFO+. You’ll have to adjust the Aux 
Env shape, but now you have complete control of the stair steps.

Semitone Cord Amt Semitone Cord Amt Semitone
Cord 
Amt

Semitone
Cord 
Amt

1 3.125 7 21.875 13 40.625 19 59.375

2 6.25 8 25.00 14 43.75 10 62.50

3 9.375 9 28.125 15 46.875 21 65.625

4 12.5 10 31.25 16 50.00 22 68.75

5 15.625 11 34.375 17 53.125 23 71.875

6 18.75 12 37.5 18 56.25 24 75.00

Quantizer

Number
of

Steps

Size
of

Steps

Cord Cord

The amount of the Input Cord determines the Number of Steps. 

The amount of the Output Cord determines the Size of the Steps. 
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26 Repeating Octave
The Repeating Octave tuning table can be used to create automatic chord inver-
sions that change the tone and flavor of your music.

The easiest way to try this out is to modify a factory preset. In preparation for 
this tutorial, load up the Proteus Composer bank.

� Doubling a Preset with a Repeating Octave:
1. Select P0000 DynamicGrand from the Tree by clicking on the little 

keyboard.

2. Select Edit, Copy from the Menu Bar.

3. Select Edit, Paste from the Menu Bar. A popup dialog box appears.

4. Select “Pasting preset after the end of the selection”. This takes a few 
seconds while 1000 presets are reordered. When the operation is complete, 
there will be a copy of the preset “DynamicGrand” in the P0001 slot.

5. Rename the new DynamicGrand in the P0001 slot to DynamicGrand2.

6. Click on the keyboard icon in the Tree of the new preset. The Preset 
Globules page appears.

7. Select the Repeating Octave tuning table.

Choose “Repeating Octave”
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8. Select P0000 Dynamic Grand from the Tree. Open the preset by clicking on 
the little (+) sign next to the little keyboard.

9. Select Links.

10. Select New Link from Links on the Menu Bar. A new empty link appears.

11. Select DynamicGrand2 for the linked preset.

12. Play the keyboard. You’ll hear both presets playing with strange inversions.

Other Tonal Variations

13. Go to the Preset Globules menu of DynamicGrand2 and change the 
Transpose to -12. Note the tonal variation as you play up and down the 
keyboard.

14. Change the Transpose to +12.

15. This example is very easy to program, yet offers a lot of interesting possibil-
ities. Try using different presets or other transpose intervals.
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This simple trick can turn a ordinary preset into something really special. 
Basically, you create several copies of a voice, change the tuning and delay the 
copies. Voice Delay is useful to create evolving or beat synchronized presets.

� Create a Voice Delay Preset:
1. Let’s start by loading the Proteus X Composer bank.

2. Select P0037 JunoPlseComp from the Tree.

3. Open the preset by clicking on the (+) symbol next to the  icon.

4. Select the Voices and Zones page.  The preset contains one 
multisampled voice.

5. Duplicate the voice two times by selecting Duplicate Voices from the Preset 
menu twice.

6. Change the Group number of the new voices to be 2 and 3 as shown above. 
This will make it easier to select them later on.

7. Set the transposition (X’POSE) of voice two to (+0), as shown above.

8. Set the transposition of voice three to (+12), as shown above.

9. Select the Voice Processing page by clicking on the icon  in the Tree.

10. Select Group 2 for processing. Because each 
of the three voices belongs to a different 
group, it’s easy to select them here.

11. Set the Voice Delay to 250 ms.

12. Select Group 3 for processing and set the 
Voice Delay to 500 ms.

13. Play arpeggios to hear the echo effect.

Other Ideas: Try different Transpose settings. 
You can change the character of the new voices 
by editing the voices (filters, envelopes, etc.). By setting the Delay to BPM, the 
echoes synchronize to the Master Tempo. Copy a voice from another preset and 
delay it.

Group
Selector

Delay

BPM Control
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28 Chromatic Glide (Glissando)
Glissando is similar to glide, except that the pitch changes in chromatic steps 
instead of a smooth slide between notes. 

This patch is not exactly obvious, but it makes sense once you know the secret. 
It’s another example of how the “Power of the Patchcords” can be used to 
create new features for your Proteus or Emulator X.

� To Add Glissando:
1. To try out this example, load the Proteus X Composer bank and select 

Preset 26: LV’s Worm from the Tree by clicking on the little keyboard. This 
is a nice monophonic lead that makes a good starting point for this effect.

2. Next click on the (+) symbol to open the preset 
modules.

3. Click on the Voice Processing icon.  The 
Voice Processing (synthesizer controls) module 
appears.

4. Select page three of the Cords section, which has a bunch of unused Cords.

5. Set-up the Patchcords as 
shown at right.

6. Key Glide is amplified 
four times, then inverted 
and routed to Pitch. This 
cancels out the normal 
Glide patch.

7. The 4x Key Glide signal is 
next sent to the Quantizer 
twice at full level (100% 
just wasn’t enough). 

The output of the 
Quantizer is then routed 
to Pitch with an amount 
of +50. (The output of the 
Quantizer determines the step size.)

8. That about does it. Now just increase the Glide time 
and play.

9. After you’ve explored glissando awhile, try, changing 
the Key Mode to Poly Normal. What’s better than 
glissando? Polyphonic Glissando!

2.

3.

6. These Cords
Cancel the

normal Glide

7. These Cords
Add the

Quantized
Glide back in
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29 Reversed Keyboard
This patch reverses the direction of the keyboard so that playing left to right will 
go from high to low pitches. 

Why would you want to do this? Well, try it and find out. You will be forced out 
of your old playing patterns and that can be a very good thing. And, it’s fun!

Incidentally, Joe Zawinul of Weather Report fame was an ardent proponent of 
this technique and used it extensively.

� One Caveat: We’re creating this patch the easy way using a single voice. It 
can be done using multiple voices, but it’s much harder.

� To Reverse the Keyboard:
1. Begin by loading the Proteus X Composer bank.

Create a New Preset

2. Select the Presets Folder from the Tree

3. Select New Preset (Ctrl+W) from the Preset menu. You can also create a 
new preset by Right-clicking over the Preset folder in the Tree.

4. Your new preset appears at the very bottom of the preset list in the Tree. 
Click on the plus symbol to open the preset.

5. Select Voices and Zones.  The Voices and Zones page appears.

6. Click on the little triangle icon  in the Sample selection field. The Select 
Sample dialog box appears.

7. Select Piano 1 C#3 and click OK.

Click here to 
select a sample.
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8. Select Voice Processing on your new preset in the Tree. The Voice 
Processing page appears.

9. Select All as the Group at the bottom of the page. Strictly speaking, you 
don’t have to do this since we only have one voice, but you need to get in 
the habit of selecting the proper voice.

10. Turn Fixed Pitch On in the Oscillator section. This disconnects the 
keyboard control of pitch.

11. Click the 10-16 tab in the Cords section 
and set up Cords 10 and 11 as shown in 
the screen at right.

12. The Cords reconnect the keyboard to 
Pitch, but in a negative direction 
(-100 -> Pitch). One Cord at 100% 
doesn’t give us enough pitch control so 
we’re using the 4X Amplifier to multiply 
it. This is exactly the amount of 
modulation necessary.

13. The keyboard pitch is now inverted (try 
it), but the pitch is one semitone off at 
C3. Set the Coarse Tuning to -1 to bring 
Middle C back up to concert pitch.

14. That’s the reverse keyboard patch. Now forget everything you’ve learned 
about the keyboard and make some truly original music.
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30 The Ever-Popular Dropping Ball Effect
Everyone has heard the sound of a ball bouncing faster as it comes to rest. It’s 
an interesting sound and very easy to create. Although the patch works best 
with percussive sounds, other kinds of samples can also be used to create other 
unique effects.

� To Create a Dropping Ball Effect:
This patch retriggers the sample using one of the LFOs. The Aux Envelope is 
used to modulate the LFO speed to make it gradually speed up. Simple!

1. For this experiment, let’s begin with P0926-Marimba from the Proteus 
Composer bank. Select the preset from the Tree and open it by clicking on 
the (+) symbol next to the little keyboard icon.

2. Set the Cords as shown in the screen below. The modified Cords are 
highlighted in Red.

3. Set up LFO1 and the Aux Env. as shown in the screen below. Getting the ball 
to drop smoothly is a little tricky. You can adjust the Aux Envelope to you 
own taste if you like.
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4. Turn up the Mod Wheel up a little to engage the dropping ball effect (when 
you play a key).

5. The charts below show all the necessary changes from the P0926-Marimba 
patch.

 

Try another Sample (Emulator X only)

6. Click Voices And Zones in the Tree. The following screen appears:

7. Change Voice Zone 1 to sample S1708 - Cow Tom by clicking on the 
triangle button and selecting sample 1708. This sample isn’t looped so it 
won’t retrigger. We can fix that easily enough.

8. Double-click on the name Cow Tom in Voice Zone 1. The Sample Edit 
window opens.

9. Click the Loop button to turn the loop on. (This sample was looped but the loop 
was turned off.) Now the sample retriggers properly.

Cord # Source Amount Destination

02 LFO 1 ~ 0.00 Sample Retrigger

12 Aux Env + 34.61 LFO 1 Frequency

Aux. Env. Atk 1 Atk 2 Dcy 1 Dcy 2 Rel 1 Rel 2

Time 0.000 0.000 1.462 17.118 0.192 0.000

Level 0.0 -3.8 15.0 93.8 0.0 0.0

LFO 1 Frequency 1.74

Step 7Step 8
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31 The Backwards Talking Game
This trick comes to you all the way back from the Emulator 1 days when 
sampling was something magic. Well, sampling is still magical and some tricks 
never get old. This one never fails to amaze.

It’s simple. Basically, you sample your voice speaking a short phrase and 
reverse the sample. Next, you learn how to pronounce the reversed phrase and 
sample your voice speaking the reversed phrase. And then (of course), you 
reverse it again!

This effect plays havoc with speech inflections and sounds like nothing else. 

� Play the Backwards Talking Game:

Record a Phrase

1. Choose Acquire from the File menu. The Acquire/Chop Samples screen 
appears.

2. Press the Record… button. The following dialog box appears.

3. Select your Microphone Input. The displayed input selections are based on 
which ASIO channels are open when the Record Audio dialog was first 
opened.

4. Set your input level. While speaking into the microphone, watch your 
meters. Adjust the input level of your audio interface or preamp. The signal 
peaks should illuminate the yellow area of the meter. The red bar at the very 
top of the meter indicates clipping and will stay on after clipping is detected. 
Left-click on either red bar to clear the clip indicator.

5. Press the Record button to begin recording and begin speaking. The Record 
Time display begins running and the Total Available Recording Time will 
begin to slowly decrease.

6. Press the Stop button (or hit the spacebar) when you’re finished recording.

Select Input Monitor Source while Recording
(to ASIO 1&2 or DirectSound)

Input Level 
Meters

Record 
Time

Record Stop Play

Keep
Sample

Discard
Sample

Total Available 
Recording Time 

Click to Clear 
Red Clip Bars

Input Level 
Attenuator
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7. Press OK to keep the sample or Cancel to discard the sample. (Pressing 
Record again without clicking OK also discards the previous sample.)

8. After pressing OK, you’re ready to set up the automatic sampling features.

9. Play the sample by pressing the button. When you’ve found the part you 
want to keep, drag the cursor over that part of the waveform. When you 
release the mouse button, Gates will mark the selected region.

Sample Overview

Display 
Zoom

Controls

Gating Display Drag cursor over 
waveform to select.

Selected Region

2. Gates

Appear

1. Drag 
to Select

Adjust 
Gates

Save 
Sample

Finish
Emulator X / Proteus X - Advanced Applications Guide 103



Special Effects
31   The Backwards Talking Game
10. You can adjust the Gates by dragging them. When you have the desired 
region selected press Save To Sampler.

11. A pop-up dialog box appears. Press OK to continue.

12. Press the Done button to exit the Acquire module.

Reverse the Sample

13. Your sample now appears in the Sample Edit module. (It’s a stereo sample 
since Emulator X only samples in stereo.)

14. Select the entire sample by double-clicking on the waveform with the 
mouse.

15. Select Reverse from the Sample Edit pull-down menu or by clicking the 
Reverse tool from the toolbar.

Practice Speaking the Reversed Sample

16. Press the Play button  to hear your reversed phrase.

17. Keep playing it over and over while you learn to pronounce the backwards 
speech.

Sample Backward

18. Think you’ve got it? Go back to the Acquire Samples... menu again and go 
through the Sampling and Reverse procedure again.

19. We guarantee weird results and maybe even a few insights.
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32 Machine Gun Drums
Some people don’t consider sampling instruments to be a true synthesizers 
because the sound source is a recording rather than a generated waveform. This 
may be partially true, but when a sampler has the ability to modify the sampled 
waveform in real-time, as the Emulator X2 does, it definitely qualifies as a real 
synthesizer. Sampling is still around because it offers what no other synthesis 
method can, the ability to play ANY sound as a musical instrument.

In this programming trick we’ll use several types of waveform modification to 
twist a snare drum sample into an effect more suggestive of granular synthesis 
than of a drum. By creating several loops and then switching through them in 
real-time, the waveform dynamically changes.

� To Make a Machine Gun Drum:

Pick a Drum

1. Find a drum sample for your source material. 
The Proteus X Composer bank contains many good 
snare drum samples, or you could select a snare drum 
from a “beat analyzed” drum track.

2. When you find the snare you want, Copy it to the clipboard (Ctrl+C).

3. Let’s start with a clean slate by creating a new bank.Choose New from the 
file menu or press Ctrl+N. A pop-up dialog box will ask if you want to save 
your changes. Choose No.

4. Click on the Samples folder in the Tree and select Paste from 
the Edit menu (or press Ctrl+V). Press OK when the paste 
dialog box appears. The sample is now part of your new bank. 
The display probably looks similar to the one shown below.

Loop Enable 
Button
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Loop it

5. Turn Looping on by pressing the Loop Enable button above the display. 
Yellow loop markers appear at the start and end points of the sample.

6. Now we have one loop, but we need a few more. Place the cursor a little way 
in from the end of the sample as shown below and drag to the beginning of 
the sample.

7. Select Make Loop From Selection from the Sample Loop pull-down menu 
or press Ctrl+Shift+L. Another set of yellow loop markers appear marking 
the section you just selected.

Drag
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8. Now repeat steps 6 and 7, but start a little closer to the start of the sample 
this time. The green lines above show the approximate positions where you 
should start dragging.

9. Make a few more loops, moving closer to the sample start each time. The 
waveform display should look something like the one shown below.

10. Increment the loop number and the currently selected loop will be 
highlighted in yellow. With only five loops, this is a rather coarse waveform 
control but it will suffice for this example. You can always add more later.

Create a Preset

11. Select the Presets folder in the Tree, then select 
New Preset from the Presets menu (or Ctrl+W). A 
new preset appears.

12. Select Voices and Zones. The page shown below appears.

13. Click on your drum sample and drag it over the empty voice as shown 
above. Now you can play the sample on your MIDI keyboard.

Loop Number

Drag
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Connect the Patchcord

14. Select Voice Processing from the Tree. The Voice 
Processing page appears.

 

15. Connect MIDI A to Loop Select (Jump) as shown above in Cord 9. Turn the 
cord amount up to 100%.

16. Play up and down the keyboard while turning the Controller Knob 
connected to MIDI A. Turning the knob selects the different loop points you 
selected. While playing higher up on the keyboard, at some point you’ll 
notice that the drum starts sounding more like a razzy tone than a drum.

Reversing a Knob

17. As you turn up the controller knob, the drum beats slow down. Suppose 
you wanted to have the drum beats speed up as you turn the knob up. 
Here’s how you reverse the action of a controller knob.

18. Set the MIDI A -> Loop Select (Jump) cord 
amount to -100%. Next add another Cord 
with DC Offset -> Loop Select (Jump) with 
an amount of +100%. Da-Da! Now the Cord 
action is reversed.

Step 15
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Here’s the Pitch!

19. Add another cord to route MIDI A to 
Pitch. Now the knob will really warp 
the snare drum.

Filter it

20. Since we have a perfectly good filter just sitting 
there we might as well put it to good use. Choose 
a 4 Pole Lowpass (for now) and adjust the 
settings as shown.

21. Turn up the filter envelope PatchCord amount.

22. Now adjust the envelope settings to give a nice 
sweep.

23. OK, now we’ve got something a little different. Continue to play with the 
filter settings, maybe change the filter type, adjust the envelope, whatever 
you like.

Other Ideas

� Use the Auxiliary Envelope to change the loops instead of MIDI A.

� Adjust the position of the loops. Moving toward the beginning of the 
sample will raise the pitch of the sound.

� Add more loops

� Add envelope control of pitch

� Use a different sample. You’ve just heard what can be done using a single 
snare drum.
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33 Voice Controlled Effects 1 - Velocity controlled echoes
The Emulator X/Proteus X allows you to control the Preset effects amount from 
the voice. This means that the amount is individually controllable for each key 
press. With this great feature you can create many wonderful effects such as:

� Velocity or pressure controlled distortion on guitars, organs or pianos

� Release velocity controlled echoes or reverb

� Chorus or Flanger amount controlled by an envelope generator or LFO.

� Ring Modulator or Pitch Shifter that only occurs during the attack.

Because the effect amounts are now controlled by your performance, this 
technique contains endless possibilities. Try it!

� How to Control the Effect Amount from the Voice
For this example, let’s set up the keyboard so that echoes only occur with low 
velocity. When you play the keys softly, you get echoes; when you play hard, 
you get no echoes.

1. First, select the preset you want (in the tree) by clicking on the keyboard  
icon. The Preset Global page appears. (Choose a sound with a fast release.)

2. Click on the Effect Select icon at the top right corner of the Effects TV 
screen. A list of available effects drops down.

� Important Note: If a preset with effects is used on more than one MIDI 
channel, the CPU usage multiplies each time the preset is used.

3. Select Delay from the list. The Effect name is now listed above the TV screen 
and the effect parameters are shown in the TV screen.

4. Play the keyboard. You should now hear the echo. Adjust the parameters to 
taste.

5. Turn up the Wet/Dry Mix to about 86% Wet.

6. Select Voice Processing from the Tree for the preset you are using. The 
Voice Page appears.

7. Select All voices for processing.

8. Find an unused Cord and set it up like this: Velocity + | -100% | Wet/Dry 
Mix.

9. Make sure the Wet/Dry Mix in the Amplifier section is set to 100 (all wet).

10. Play the keyboard soft and hard to check it out.

11. To reverse the action (hard = echo; soft = no echo), make the Cord amount 
+100 and set the Wet/Dry Mix to 0. (You may also want to reduce the Wet/
Dry mix in the Echo effect itself to obtain the proper response.) Now that 
you’ve got it all set up, try changing the Preset Effect. Try reverb, flanger, 
phaser and distortion effects.
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34 Voice Controlled Effects 2 - Envelope Gated Effects
This time we’re going to set up the effects so they are gated on only when the 
key is released. Then, we’ll add a footswitch control to enable or disable the 
effect.

� Gating Effects Using an Envelope
1. First, select the preset you want (in the tree) by clicking on the keyboard  

icon. The Preset Global page appears. (Yo My Dynos from the Proteus X 
Composer bank works well.)

2. Click on the Effect Select icon at the top right corner of the Effects TV 
screen. A list of available effects drops down.

3. Select Phaser from the list. The Effect name is now listed above the TV 
screen and the effect parameters are shown in the TV screen.

4. Play the keyboard. You should now hear the phaser. Adjust to taste.

5. Turn up the Wet/Dry Mix in the effect to about 60% Wet.

6. Select Voice Processing from the Tree. The Voice Page appears.

7. Select All voices for processing.

8. Find an unused Cord and set it up like this: Aux Env + | +100% | Wet/Dry 
Mix.

9. Set the FX Wet/Dry in the Amplifier section is set to 0 (all dry).

10. Set up the Aux Envelope as shown below. This gives a decay curve only 
when the key is released.

Release 1 Time = 0.370; Release 1 Level = 100; Release 2 Time = 2.848

11. Play the keyboard and hold the keys down. No Phaser. Now release the 
keys. Phasey!

12. Now you’ll want try out all the different effects. And of course, you can alter 
the shape of the envelope.

13. To turn the effect on and off using a footswitch, simply set the amount of 
the Aux Env Cord to +0.00. Next, set up another cord like this:
Footswitch | +100 | Aux Env Cord Amt. The effect will only be heard on 
release IF the footswitch is depressed.
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35 Assigning Multiple VST Busses in Cubase LE
In this tutorial we’ll show you how to assign MIDI channels to separate VST 
busses and then assign different VST effects to each bus. Bussing MIDI channels 
also allows you to separately EQ each MIDI channel if you so desire.

� To Assign Multiple VST Busses:
1. Open Cubase LE.

2. Select New Project from the File 
menu. When asked, select Empty.

3. From the Project menu, select 
Add Track, MIDI. An empty MIDI 
track appears. Create 3 MIDI tracks.

4. From the Devices menu, select VST 
Instruments. The VST Instrument 
dialog box appears.

5. Click in the field that says No VST 
Instrument and a pull-down menu 
appears. Select the Emulator X or Proteus X VSTi.

6. Click the e in the VSTi instrument dialog box to edit the instrument. The 
Proteus X or Emulator X main page appears.

7. From the Options menu, select Preferences.

Click the e to open the Proteus X 
or Emulator X VSTi.
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8. Select the number of output buses you wish to use. For the purposes of this 
tutorial, select 3 Output Buses. Click OK. The following dialog box appears:

9. This means that you’ll have to select No VST Instrument in the VST Instru-
ments dialog and then repeat steps 6 & 7.

10. When the Emulator X / Proteus X is back in view, Open a bank from the 
File menu. For the purposes of this tutorial, select Proteus X Composer. 
(The one bank everyone has.)

11. Click on the 1-16 tab to select the Multi-channel view.

12. Assign presets to channels 1, 2 and 3.

13. Select the OUTS tab. This is where 
you assign MIDI channels to busses 
in the Proteus X or Emulator X. 
Assign the first three channels to 
Busses 1, 2 and 3 as shown at right.

Multi-channel View Outputs
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� Note that the Aux Outputs can also be assigned to busses. 
Using the Aux Outputs allows you to control the send 
amount from each voice if you so desire.

14. Now that you have the busses assigned to MIDI 
channels, you can close both the Proteus X / Emulator 
X editor and the VST Instruments dialog box.

Connect MIDI

15. The next step is to connect your MIDI keyboard to 
the track and the track output to the Emulator X / 
Proteus X.

16. If the “Inspector” pane (shown at right) is visible on 
the left side of the Cubase window, you can go on 
to the next step. If it’s not visible, click the Show 
Inspector button just below the Cubase title bar.

17. Select MIDI Track 1 by clicking on it and click 
anywhere inside the In field and choose your MIDI 
interface.

18. Click anywhere in the Out field and choose either 
the EmulatorXVSTi or ProteusXVSTi.

19. Play your MIDI keyboard. You should see MIDI 
activity on the MIDI Activity Indicator on the 
Cubase Transport Panel.

20. You should also be hearing the Emulator X / Proteus X. If not, check that 
the MIDI track is Record Enabled with the button showing red.

21. If you still aren’t hearing sound, open the Emulator X / Proteus X editor 
again by clicking the Edit button  in the Inspector pane. Click the Mini 
Keyboard button, then play the mini keyboard with your mouse. If you 
hear audio, you have a MIDI connection problem. If you don’t hear audio, 
then you have an audio connection problem.

Set up MIDI Tracks 2 and 3

22. Select MIDI track 2 by clicking on it and set the input and output as you 
did in steps 18 and 19. 

23. Make sure the Channel (chn) field is set to:
chn 1 for track 1
chn 2 for track 2
chn 3 for track 3

� Explanation: When the chn field is set to a channel number (1-16), Cubase 
accepts any MIDI channel number from your MIDI keyboard and reassigns 
it to the number you have selected.

In
Out

MIDI
In
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Connect a VST Effect to Bus 1

24. From the Devices menu in Cubase, select Mixer (F3). The track mixer 
window appears. Note that there are 3 tracks associated with the Emulator 
X or Proteus X busses you created.

It’s a little confusing because the bottom lines all say “Bus 1”. Click on the 
top line labels to see the connection.

25. Click on the Edit VST Channel button, on Bus 1 as 
shown at right. The VST Channel Settings window, 
shown below, opens.

VSTi Busses 1-3MIDI Tracks

Click Here

Edit VST 
Channel

Bus 1
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26. Click inside the field that reads “No Effect” 
and the list of available VST effects appears. In 
this example we have a Grand Piano on MIDI 
Channel 1 (and Bus 1), so we’ve chosen Reverb 
B from the Cubase VST collection.

27. The Reverb B controls appear. Play your MIDI 
keyboard and select a reverb preset or set the 
controls to your taste.

Connect a VST Effect to Bus 2 and Bus 3

28. Hit the F3 key to bring the Mixer up front.

29. Click on the Edit VST Channel button, on Bus 2 
and the VST Channel Settings window appears.

30. In this example we have a B3 Organ on MIDI 
Channel 2 (and Bus 2), so we’ve chosen 
Distortion for this bus.

31. The Distortion controls appear. Play your MIDI 
keyboard and select a distortion preset or set the 
controls to your taste.

32. Repeat the last three steps for Bus 3. Choose a Delay for Bus 3.

Equalization

33. You must have noticed 
the four-band equalizer 
on the VST Channels 
Settings page. Another 
advantage of using 
multiple busses is that 
you can apply separate 
EQ to each of your 
MIDI tracks.

Recording

We should probably finish up by telling you how to record your 3 MIDI tracks.

34. You now have 3 MIDI tracks all set up to record. All you have to do is select 
the track and hit Record, then Play on the Cubase Transport Panel.

35. To record the next track, hit RTZ on the Cubase Transport, select the next 
track and hit Record, then Play to begin again.

RecordPlay
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Have you ever wanted some special feature on your instrument and wished you could 
write the software to add it? Well, in many cases you CAN create up your own custom 
features using a little creativity and the extensive patching capabilities of the Emulator X 
and Proteus X. 

When using a synthesizer of this depth and complexity there is almost always more than 
one way to achieve your desired result. Try to approach the problem from a different 
mindset. Even if your first solution doesn’t work, you might discover something new and 
exciting - or even the synthesist’s holy grail of discovering an entirely new sound or effect.

Our sincere hope is that these lessons may stimulate your imagination as to the infinite 
possibilities of using these powerful musical tools.
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A sostenuto pedal sustains any notes being held at the time the pedal was 
pressed, but doesn’t sustain notes played afterwards. Sostenuto is usually only 
found on expensive pianos, but it is an extremely musical control. It’s even 
more useful on a synthesizer since you can infinitely hold the notes.

The Emulator X/Proteus X doesn’t have a dedicated Sostenuto pedal feature, 
but this great feature can be implemented using the incredible power of the 
Patchcords. The patch is a little complicated and uses up six patchcords, but it 
works.

A complete explanation of the patch is given for those interested, but you can 
still use the patch whether you understand it or not.

� Before you Begin
1. Make sure you have a sustain footswitch connected to your MIDI controller 

and that it is working. We use Footswitch 1 for this example.

2. Choose a preset that sustains when you hold the keys down.

3. Look through the four pages of the Patchcords and turn off Footswitch 1 
wherever you see it. Alternatively, If you have two footswitches, you can 
leave Footswitch 1 connected as a Sustain pedal and use Footswitch 2 for 
the Sostenuto pedal.

� To Program a Sostenuto Pedal:
1. This patch requires 6 consecutive patchcords. The order of each cord is 

important, so program the patch EXACTLY as shown below.

2. Play a chord, then press the footswitch. Play some more notes and notice 
that they don’t sustain. Only notes being held when the switch was pressed 
will sustain.

 Sostenuto Pedal Patchcords

Source Amount Destination

DC Offset +1.00 Switch

Footswitch1 -1.00 Switch

Switch +1.00 Switch

Switch +1.00 Key Sustain

Footswitch1 +1.00 Key Sustain

DC Offset -1.00 Key Sustain
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� How it Works
Refer to the block diagram of the patch as shown below. We’ll analyze the three 
possible states of the keyboard keys and footswitch in relation to the Switch 
and then the Key Sustain modules. It’s important to realize that the state of the 
network is calculated for EACH KEY pressed and that lower numbered Cords 
are calculated first.

Footswitch Always Up

1. If the Footswitch never goes down, the network doesn’t affect Key Sustain. 
The algebraic sum of the three Switch inputs is positive and so the output of 
the Switch is high (+1). The Switch inputs are calculated below.

FtSw = 0
DC = +1
Switch =  +1 (feedback from output)
SwOut = +1

Because the output of the Switch feeds back into itself, it Latches the 
current state, which in this case is +1.
The algebraic sum of the Key Sustain input is zero and therefore no sustain 
occurs. The Key Sustain inputs are calculated below.

Switch=+1
FtSw =0
DC =-1
KeySus =0

Switch

Sostenuto Network
(Footswitch Always Up)

Key
Sustain

Foot
Switch

Switch outputs +1
when sum of inputs
is greater than zero.

No SustainDC

Feedback (latches the switch)

DC
(up)

+1

+1

0

0

+1

-1

0

0
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Footswitch already Down when Keyboard Keys are pressed

2. If the Footswitch is already depressed when keyboard keys are pressed, the 
network doesn’t affect Key Sustain. The algebraic sum of the Switch input is 
0 and so the Switch output is Low (0). Switch inputs are calculated below.

FtSw = -1
DC = +1
Switch = 0  (feedback from output)
SwOut =  0

Because the output of the Switch feeds back into itself, it Latches the 
current state, which in this case is 0. 
Again, the algebraic sum of the Key Sustain input adds up to zero and 
therefore any played keys do not sustain.
The Key Sustain inputs are calculated below.

Switch = 0
FtSw = +1
DC = -1
KeySus = 0

3. The Sostenuto Pedal - The Sostenuto action occurs ONLY when the 
footswitch is pressed while keyboard keys are being held.

Switch

Sostenuto Network
(Footswitch Already Down when

Keyboard Keys are pressed)

Key
Sustain

Foot
Switch

Switch outputs +1
when sum of inputs
is greater than zero.

No SustainDC

Feedback

DC
(down)

0

+1

+1

-1

0

+1

0

(pressed)

(pressed)

-1

Switch

Sostenuto Network
(Footswitch pressed while

Notes are being held)

Key
Sustain

Foot
Switch

Switch outputs +1
when sum of inputs
is greater than zero.

SustainDC

Feedback (latches the switch)

DC

(Pressed after
notes played)

+1

+1+1

0, then -1

0, then +1

0, then +1

-1

+1(latched)
120 EMU Systems, Inc.



Advanced Applications
36   Sostenuto Pedal
We begin with the state described in Step 1 with the pedal in the up position. 
Played notes do not sustain.

FtSw = 0
DC = +1
Switch = +1 (feedback from output)
SwOut = +1

Because the output of the Switch feeds back into itself, it Latches the 
current state, which in this case is +1.
Now the Footswitch is pressed. The output of the Switch remains latched.

FtSw = -1
DC = +1
Switch = +1 (feedback from output)
SwOut = +1

The algebraic sum of the Key Sustain input now adds up to +1 and so any 
notes held at the time of the footswitch depression will sustain. The 
footswitch change of state causes the Sostenuto action.

Switch = +1
FtSw = +1
DC = -1
KeySus = +1

Any new notes played after the footswitch depression fall into the category 
described in step 2 and will NOT be sustained.

Although this example was particularly complex and the explanation 
somewhat long-winded, it illustrates the concepts of Patchcord feedback 
and latching.
Now that you know the trick, you can latch any Patchcord destination 
using the Sostenuto-type action. Just substitute the parameter you want to 
latch instead of Key Sustain.

Tip: You probably already know this, but if you don’t want the Sostenuto 
action and just want a regular footswitch to latch (press once-on; press 
again-off), all you have to do is substitute a FF Footswitch for the regular 
footswitch in the PatchCord sources.
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37 Creating Unusual Envelopes
The envelope generator timings can be modulated with anything—an LFO, 
keyboard velocity, keyboard key, or even the output of the envelope generator 
itself!

Envelope Self-Modulation

For example, modulating the Attack with the envelope’s own output (positive 
modulation) results in an attack time that gets faster and faster as the attack 
progresses.

Positive self-modulation on the envelope rates creates Logarithmic curves. 
Negative self-modulation on the envelope rates creates Exponential curves. 
Exponential curves are nice to use with slow string attacks, while logarithmic 
curves work well for pitch bends. You can even modulate the Cord amount, 
(with key or velocity, for example) to dynamically change the envelope shape.

� To Change the Shape of the Envelope:
1. Open any preset and open the Voice Processing page.

2. Select All Voices in the voice selector.

3. Find two unused Patchcords and program them as shown below.

4. Adjust the Aux Envelope curve as shown below. You should hear the pitch 
slowing rising when you play a note.

Cord Source Amount Destination

28 Aux Env + +12.00 Aux Env Rates

29 Aux Env + +21.87 Pitch

Envelope
Generator

Env.
Rates

Cord

Positive Cord amounts = Logarithmic curves

Negative Cord amounts = Exponential curves
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5. Increase the amount of Cord 28 to about +75. Play a key. You should now 
hear the Attack increase speed as it nears 100%.

6. Set the Envelope Attack time to .4 seconds and set Cord 28 to -60. Play a 
key. Now the attack starts fast and slows at it nears 100%.

7. Since we’re modulating ALL the rates, all stages of the envelope will be 
affected by the self-modulation. Try adjusting the decay and release times 
and note the effect.

8. Change the destination of Cord 28 from Aux Env Rates to Aux Env Attack, 
or Aux Env Decay. Now the self-modulation only affects a single stage.

LFO Modulation of Envelope Sustain

You can patch an LFO to modulate the Sustain segment of an envelope so that 
the LFO only comes in during the Sustain phase of the envelope. The Attack 
Decay and Release rates can also be modulated with an LFO, although the effect 
is a little more subtle.

� To Modulate Envelope Sustain with an LFO:
1. Set the Aux Envelope approximately as shown below. 

2. Set up the Patchcords as shown below and play the keyboard.

3. Try modulating the envelope rates with the LFO. You may have to adjust 
the initial rates in order to hear the effect.

Cord Source Amount Destination

28 LFO 1 ~ +50.00 Aux Env Sustain

29 Aux Env + +21.87 Pitch

LFO modulating Sustain phase
Emulator X / Proteus X - Advanced Applications Guide 123



Advanced Applications
38   Resampling
38 Resampling
Although there is no dedicated “Resampling” feature on the Emulator X, you 
can resample the output with a bit of patching. Resampling allows you to 
include modulation, filters and effects in your sample, or you can record runs 
or chords, or a even an entire song. The basic idea of resampling is to make the 
Emulator X output available as an ASIO input to the Record Audio dialog box. 
This is pretty simple. Here’s how:

� To Resample the Emulator X using PatchMix DSP:
1. Open Emulator X in standalone mode (not as a VSTi), and select the preset 

you wish to resample.

2. Open PatchMix DSP by clicking on the EMU icon  in the Systray.

3. Play your MIDI keyboard and determine which input strip Emulator X is 
using by observing the peak meters. (You can right-click to add peak meters 
to the channels if there are none.)

4. Add an ASIO Send to the input channel used by the Emulator X.

5. Select Acquire Samples from the Emulator X File menu (Ctrl+Q).

6. Press the Record button from the “Acquire/Chop Samples” dialog box. The 
“Record Audio” dialog box appears.

7. Select EX Main as the Input. If EX Main doesn’t appear, make sure you’ve 
loaded the default Emulator X template in PatchMix DSP. Make sure that 
the Monitor button is off (as shown) or you will hear annoying feedback as 
soon as you play the Emulator X.

8. Play your MIDI keyboard. You should hear it and see activity on the meters 
in the Record Audio dialog box above.

9. Press the red Record button , then start playing.

10. Press the Stop button  when you’re finished resampling.

11. Continue to chop and process your samples. 

Select 
EX Main

Monitor OFF 
(as shown)
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� To Resample the Emulator X using an E-MU 0404 USB 
(or another audio device)

1. Open Emulator X in standalone 
mode (not as a VSTi), and select the 
preset you wish to resample.

2. Connect the Outputs to the Inputs 
of your audio device.

3. Play your MIDI keyboard and set the 
input levels on your audio I/O 
device. The meters should not clip.

4. Select Acquire Samples from the 
Emulator X File menu (Ctrl+Q)

5. Press the Record button from the 
“Acquire/Chop Samples” dialog box. 
The “Record Audio” dialog box 
appears.

6. Select the proper input as the Input. 
(0404 USB shown) Make sure that the Monitor button is off (as shown) or 
you will hear annoying feedback as soon as you play the Emulator X.

7. Play your MIDI keyboard. You should hear it and see activity on the meters 
in the Record Audio dialog box above.

8. Press the red Record button , then start playing.

9. Press the Stop button  when you’re finished resampling.

10. Continue to chop and process your samples.

� Digital Resampling without PatchMix
This should work depending on your audio device. At the time of this writing 
the 0404 USB could not resample using S/PDIF, but this issue should be 
addressed in a future software version.

Resampling using S/PDIF should work just like analog resampling. Patch input 
to output, then set the Emulator to output S/PDIF in the Multisetup and input 
S/PDIF in the Record dialog box.

Power On

Mic / Hi-Z / Line

48V On

Direct Monitor

-12
-6

ClipClip

Optical
Coaxial

-12
-6
-3

Sync Status

ExtInt

InOut

MIDI

Hi-Z / Line MicA Hi-Z / Line MicB

S/PDIF

Main Output

Mic / Hi-Z / Line

Direct Monitor

Level

Level

Level

Headphone

-3

-18

0 0

SLSL

-18

Sync Status

MIDI

∞

S/PDIF
Main

Off

Mono On

+65 +65

+0dB

Connect
Outputs to Inputs
(balanced or unbalanced)
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39 Pulse-Width Modulation
They said it couldn’t be done! It’s true, you can produce true pulse width 
modulation (PWM) using the Emulator X.

The basic idea of pulse-width modulation is to start with a looped single-cycle 
wave, then dynamically move the loop location so that different portions of the 
waveforms are included. Changing the loop length will change the pitch of the 
sample, but this is easily corrected using the Transpose and Tuning controls in 
the Voice. The diagram below illustrates the principle.

� To Pulse-width Modulate a Square Wave:
1. Turn Streaming Off in the Options, Preferences menu. Pulse width 

modulation needs to have the entire sample loaded into RAM for proper 
operation.

2. Load the Proteus X Composer bank.

Copy the Sample

3. Select the Samples folder in the Tree.

4. Open the Samples folder by clicking on the
(+) symbol.

5. Locate sample S0766 - Square E3 in the
Tree, and select it. 

6. Select Copy from the Edit menu.

7. Select Paste from the Edit menu. The 
following dialog box appears.

8. Choose Pasting 1 sample 
“After the end of the selection.” 
Also choose “Move existing objects 
if necessary.”

9. A duplicate of Square E3 appears in 
sample location S0767.

S E

S E

Pulse-Width Modulation
The loop length is fixed, then the 
loop position is modulated with 
an LFO or Envelope so that it 
changes the duty cycle of the 
waveform.
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10. Right-click on S0767, then choose Rename (F2).

11. Rename the sample to PWM E3.

Create a new Preset

12. Select the Preset folder in the Tree. 

13. Select Presets, New Preset from the 
menu bar.

14. Open the Preset Folder by clicking
on the (+) symbol and scroll down to the bottom of the preset list. A new 
empty preset has been created at the bottom of the Tree (location P1026).

15. It’s always a good idea to rename your new preset to avoid confusion later. 
(Right-click on the preset name, then choose Rename or press F2.)

Assign the Sample

16. Open the preset by clicking on the (+) symbol next to the little  icon.

17. Open the Voices and Zones module. The Key Window appears.

18. Select sample S0767 - PWM E3 (a pulse width modulation sample).

Adjust the Loop Markers

19. Double-click on the sample name to open the sample editor.

20. Move the Loop End Point by dragging the marker or by typing in a value 
into the End field. We have chosen a value of 69 samples for the loop length 
in the example above. The distance from the start point sets the initial pulse 
width and pitch of the sample.

21. It’s easy to see how the loop will move if you click the Lock loop length 
button and then move the loop start point. Try this and note how the pulse 
width changes inside the loop markers. When you’re finished, move the 
loop start point back to 8 samples and the end point to 77 samples (Loop 
Length = 69 samples).

Click the Sample Button 
to select a sample

Double-click here to 
open the sample editor
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Retune the Sample

22. Unfortunately, because we changed the loop length, the waveform is no 
longer tuned to E3. Fortunately, this is easy to fix. Click the Back Arrow  to 
jump back to the Key Window.

23. Select New Voice (Crtl+W) from the Preset menu. A new empty voice 
appears.

24. Click the button next to the voice and select sample S0766 - Square E3 (the 
original square wave sample).

25. Click the Mix/Tune button.  The Voices and Zones page should look 
like this:

26. Play the keyboard. Both voices will sound and they will be horribly out of 
tune. Adjust the Transpose and Fine Tune controls on Voice 1 until they are 
in tune. Now the PWM E3 voice is back in pitch.

27. Select Voice 2 (S0766 - Square E3) and select Delete Voices from the Preset 
menu since it’s no longer needed.

Move
Loop End

Point
128 EMU Systems, Inc.



Advanced Applications
39   Pulse-Width Modulation
Connect the Modulation Cords

28. Select the Voice Processing page from 
your new preset (P1025) in the Tree. The 
voice processing page appears.

29. Set up the Cords as shown at left. You only 
need to change two parameters. Set Cord 
3’s destination to LFO~ to Sample Loop, 
and change the Amount of Cord 4 to -2.00.

30. Play the keyboard and turn up the Mod 
Wheel. You should now be hearing rich, 
luscious pulse width modulation.

31. You might want lower the frequency of 
LFO 1 for a better chorale effect.
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40 Quad Panning and 3D Effects in Stereo 
This effect swirls the sound around four speakers using the LFO. Since the patch 
is in the voice, each key will have its own circular pan.

Incidentally, you can try out this effect even if you don’t have a multi-channel 
speaker system. A great pseudo-surround effect can be created with only two 
speakers by assigning a reverb to the rear channels. It’s a very cool effect.

At first glance, the Emulator X and Proteus X appear to be stereo-only instru-
ments with no provision for surround sound. But wait, there are actually four 
stereo outputs and the amounts all four stereo buses can be modulated by any 
of the voice modulation sources. There ought to be a way, and there is!

The trick to implementing a smooth quad panning effect is to use something 
called a quadrature sine wave, or two sine waves 90 degrees out of phase with 
each other. One sine wave moves the panning left and right and the one shifted 
90 degrees out of phase pans the sound front to back.

The easiest way to do this on the Emulator X or Proteus X is to use two sine 
wave LFOs and shift one of them 1/4 cycle using the delay parameter.

� To Implement Quad Panning:

1. Let’s start by loading the Proteus X Composer bank.

2. Select P002 Orchestral from the Tree.

3. Open the preset by clicking on the (+) symbol next to the  icon.

4. Select the Voice Processing page. 

5. Select All in the Voice Selector to select all voices for processing.

6. Select the LFO/LAGS page by clicking on the tab.

7. Select Sine for both LFOs and set up the parameters as shown with a 
Frequency of 1 Hz and a delay of .25 seconds for LFO 2. (One quarter of a 
cycle equals 90 degrees.) Make sure Key Sync is on.

8. Now moving over to the Cords section, select the 19-27 tab, which has a 
few available cords.
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9. The Cord patching is shown 
at right. LFO 1 is being used 
for the left-right Amp Pan 
and LFO 2 is handling the 
front-back movement by 
controlling the Main and 
Aux 1 Sends. 

10. The front-back panning 
works a little differently. The 
Main and Aux Sends have a 
range of 0-100 so we use two 
Cords, one to turn the Main 
(front) channels down from 
its normally-on state, and a 
second Cord to turn the Aux 
1 Send up from its normally-
off state.

11. The initial amount of the Main is already 
100% and the initial amount of the Aux 1 
Send is already set to 0%, so you don’t have to 
change these. The main point here is that the 
inverted polarity of Cord 23 turns the Main 
amount down at the same time that Cord 24 is 
turning the amount of Send 1 up. And because 
LFO 2 is 90º out of phase with LFO 1, the 
circular panning motion is achieved.

12. You will probably want to turn Classic 
Response Off to get a more natural sounding 
panning effect. (Classic Response is only used for Emulator IV compatibility.)

13. Turn down Aux 1 (CTRL K Initial MIDI Controller Amount (Multisetup 
screen) since this is turned up slightly in the Orchestral patch.

Routing your Outputs

14. Now we need to send the output of Aux 1 to its own 
pair of ASIO channels on your sound card. Click the 
Emulator X (or Proteus X) icon above the tree to return 
to the main screen. Set Aux Output 1 to another set of 
outputs on your sound card. We’re using an E-MU 
1616M and using Dock Outputs 2L & 2R for the rear 
channels. 

15. Here’s how the PatchMix session looks. Remember that you have to create 
ASIO strips BEFORE they will appear in the Emulator X or Proteus X appli-
cation. Here we have created an ASIO 3/4 strip for the Rear channels and 
Muted the strip to disconnect it from the Main outs (our front speakers). 

Left/Right 
LFO

Front/Back 
LFO
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16. The patch is now complete. The sound spins in a circle panning between 
four speakers. To make the rotating less severe, slightly decrease the Cord 
amounts controlling the panning.

� You can incorporate quad panning into your existing 5.1 surround setup by 
simply ignoring the center and sub speakers.

� 3D Stereo-Holo-Simulacra™

17. At the beginning of this tutorial, we mentioned that you could use this trick 
in stereo to create a pseudo-quad effect. Here’s how.

18. Set the Aux 1 Output to Main.

19. Set Aux FX 1 to Reverb (or Phaser or ??). The reverb effect simulates the rear 
channels and adds a nice three-dimensional quality to the sound. In fact, 
this might be the beginning of a nice Leslie (rotating) speaker effect.

� Other Ideas: Use envelope generators, function generators or MIDI 
controllers to control the panning. Try using non-synced LFOs with 
different shapes.

RearTo Main 
Outs
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41 X-wave Synthesis
This patch is based on classic instruments such as the PPG 2.2, Waldorf wave 
and Sequential VS. Rather than spending your money on another synth, you 
can patch up your own crosswave synthesizer on the Emulator or Proteus X.

� Locate Samples and Load them into the Bank
1. Make sure you have either the Proteus Composer or Proteus X Composer 

bank on your hard disk.

2. Let’s start with a clean slate. Select New from the File menu.

3. The easiest way to find samples is using the Library feature. Click the 
Library Tab at the bottom of the Tree.

� Important: If the Librarian doesn’t find the samples, select Update Library 
from the File menu. (You need to have Proteus X Composer in your System.)

4. Select Wave as the Category, and leave the ‘Filter by Name’ box blank. Click 
Search.

5. Clicking on the Samples Folder in the Tree displays the expanded list in the 
main window.

6. The window should look something like the one shown above, although 
you may have more samples shown, depending on the size of your sample 
library.

Library Tab
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7. Browse through the Wave samples until you find one that you think you 
might want to use. Click on the sample name and hit the Space-bar on 
your computer keyboard to audition the sound from the hard disk.

8. If the sound doesn’t stop on it’s own, hit the Space-bar again to Stop.

9. When you find an interesting wave sample, select the sample while holding 
the mouse button, drag and drop it on top of the Emulator X/Proteus X 
icon above the Tree as shown below.

10. Continue browsing the wave samples, auditioning them and adding them 
to the bank. Choose about five or six waves.

11. Click the Sampler Tab at the bottom of the Tree, then double-click the 
Samples Folder to open it. You’ll notice that the samples have now been 
added to the Bank.

Time to Save?

12. Have you have done enough work that you’d HATE to lose it? If so, then it’s 
time to save.

13. Select Save As... from the File menu, choose a location where you can find it 
again (the desktop?), and press Save.

� Placing the Samples on the Keyboard
1. Click on the Presets Folder in the Tree, then select New Preset (Ctrl+W) 

from the Presets menu. A new preset appears in the Tree.

2. Select Voices and Zones in the new preset. The Voices and Zones page 
appears.

3. Select the first sample from the list in the Tree, then drag and drop it over 
the empty sample location as shown below.

4. Click the KEYWIN tab. A green bar appears across the entire keyboard 
range indicating that the sample is transposed across the entire keyboard. 

Drag and Drop

Drop Here
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The red bar shows the original key. Because the original pitch of the sample 
(A2) is included in the name, Emulator X/Proteus X is smart enough to 
place the original pitch on the proper key.

� Important: If the original key of a sample is 
on the wrong key, the sample will be out of 
tune. The original key selection field is 
always visible regardless of which tab is 
selected.

5. Play the keyboard. Since the sample is transposed over the entire keyboard 
range you can play it polyphonically at any pitch. But as you play in the 
upper part of the keyboard, notice that the sound doesn’t sound so natural 
anymore. This is a result of the sample transposition. To overcome this 
problem we add more samples.

6. Select the next sample from the list in the Tree, then drag and drop it 
anywhere in the Key Win area as shown below.

7. A new voice appears in the window. Continue creating new voices using the 
rest of the samples by dragging and dropping them into the Key Win area.

8. Play the keyboard. Since the keyboard range encompasses the entire 
keyboard, you’ll hear all the voices together.

Cross Switch the Voices.

9. Select the RT WIN tab. The Real-time control window lets you switch or 
fade voices according to the setting of a Control Knob, Envelope, LFO, or 
Function Generator.

10. Divide the range up for each of your voices more or less equally as shown 
below. Make sure the ranges do not overlap each other. Using the example 
below: Voice 1 = 0-25; Voice 2 = 26-50; Voice 3 = 51-75; Voice 4 = 76-100; 
Voice 5 = 101-127.

Original Key Selection
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11. Select Voice Processing from the Tree. The Voice processing page appears.

12. Select All voices using the group selector, located below 
the Envelope display. This step is important to ensure that you are editing 
all the voices.

13. Set up Cord 9 as shown with MIDI A 
connected to Amp Crossfade, with an 
amount of +100.

14. Now play the keyboard while turning the knob assigned to Controller A 
(You do have your controller knobs assigned, don’t you? If not, go to page 13.) 
You’ll hear the waves you assigned being switched as you turn the knob.

Transpose

15. Are the pitches in the same octave? 
To transpose a single voice, select 
just that voice, then change the 
Transpose setting using the knob.

Automatic Control

16. Next we’ll assign an LFO to control the cross-switch. Make sure all voices are 
selected, then set LFO1 + as the modulation source instead of MIDI A.

17. Now we have some timbrel animation going! Try out a different LFO rate 
and some other waveforms.

18. Now try assigning an Envelope Generator 
to control the cross-switch. Make sure all 
voices are still selected, then set Aux Env + 
as the modulation source.

19. Select the Aux Env tab and play with the 
Envelope settings. You can really twist the 
timbre around using an envelope or 
function generator as the control source.

20. Turn Envelope Repeat On. The Attack 
(1&2) and Decay (1&2) stages will 
continue to repeat as long as the key is held.

Crossfading

21. Next, let’s crossfade the voices instead of abruptly switching them.

22. Hold the Alt-key, then click and drag on the range bars to effect a 
crossfade. You can also type into the RT numeric fields (lower right corner).
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23. Set your crossfade ranges as wide or narrow as you like. The example shown 
above works well, but you may like the sound better with longer crossfade 
ranges. Adjust the crossfades until the waves blend smoothly together as 
you turn the knob.

� Important: After adding the crossfades, you may have to deselect the Cord 
control of Amp Crossfade, reselect all voices, then re-connect the Cord.

Filtration

24. You have a fairly complex sound happening 
and you haven’t even used the Filters or 
other Cords yet! Select the 4 Pole Highpass 
filter and turn up the resonance a bit.

25. Turn up the Envelope Amount a bit. It’s 
already patched for you on Cord 6.

26. Adjust the Filter Envelope to your own taste.

Add FX

27. A little delay always works with synth sounds. Select the Preset Globals page 
by clicking the icon in the Tree.

Hold the Alt key, then click & drag to crossfade.
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28. The BPM Delay is nice. Not too much, but 
with a little feedback. Ahhh!

Those Function Generators!

29. You might have already jumped ahead of us 
and tried the Function Generators. If not it’s 
time to hook these bad boys up. As it turns 
out, the Function Generators are just about 
the perfect controller for crossfading.

30. Select Function Generator 1 + as the source 
for the Amp Crossfade.

31. Turn on the Smooth button and you can draw in the timbrel envelope with 
your mouse. Try out all the controls. You’re there.

� Something You Should Know: Real-time crossfade is inherently wasteful of 
voices because all the voices in the stack are triggered on each key press. In 
this example, we’re using 5 voices per key. This can eat up your available 
polyphony in a hurry.

� Extra Bonus Tip: Rearranging the Order of Voices
If you want to rearrange the order of your voices when cross-fading or cross-
switching, this is probably the easiest way to do it.

1. Choose a new order for your voices, then set the Group number for each 
voice in the desired order as shown below.

Arrange Voice numbers in the desired order.
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2. From the Preset menu, select Sort Voices, By Group. Now the voices are in 
the desired order from top to bottom, but the Real-time control ranges are 
wrong.

3. Unfortunately, there is no automatic way of setting the real-time ranges. 
You’ll have to manually restore the range settings as they were before. The 
sorting operation makes this job easier and less prone to confusion.

4. Slowly switch through the voices with Controller A and listen. Do you like 
the order? If not, rearrange them again.
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42 TwistaWave
Although TwistaLoop was designed for twisting audio phrases rather than 
single-cycle waves, there’s no reason why we can’t adapt the technology to 
create another synthesis method. Using this method we are able to re-shape the 
spectral components of a sampled wave.

Historically when a wave was sampled, it was like taking a single snapshot of 
the sound. Although you could apply filtering and volume shaping, the spectral 
evolution of the sound was pretty much fixed.

Using Emulator X, we can create multiple single-cycle loops, then wave 
sequence these loops using an envelope, LFO or Function Generator. This is 
similar to a motion picture where still pictures are sequenced to create a 
dynamically changing image.

� Locate a Sample and Load it into the Bank
1. Let’s start with a clean slate. Select New from the File menu.

2. You’ll get the best results by choosing a wave that has a fair amount 
harmonic evolution going on. We’ve chosen Syncwave 1 C2 from the 
Proteus X Composer bank.

3. You can find this sample easily using the Library feature. Click the Library 
Tab at the bottom of the Tree.

� Important: If the Librarian doesn’t find the samples, select Update Library 
from the File menu.

4. Type “Syncwave” in the ‘Filter by Name’ box, then click Search.

5. Select the Syncwave 1 C2 sample and while holding the mouse button, 
drag and drop it on top of the Emulator X icon above the Tree.

6. Click the Sampler Tab at the bottom of the Tree, then double-click the 
Samples Folder to open it. You’ll notice that the Syncwave 1 C2 sample has 
now been added to the Bank.

� Placing the Sample on the Keyboard
1. Click on the Presets Folder in the Tree, then select New Preset (Ctrl+W) 

from the Presets menu. A new preset appears in the Tree.

2. Select Voices and Zones in the new preset. The Voices and Zones page 
appears.
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3. Select Syncwave 1 C2 from the sample list in the Tree, then drag and drop 
into the empty sample area as shown below.

4. Syncwave 1 C2 now appears in the sample field.

5. Play the keyboard. Since the sample is transposed over the entire keyboard 
range you can play it polyphonically at any pitch.

� Creating Multiple Loops
1. Double click on the Syncwave 1 C2 name in the sample field. The Sample 

Edit window opens.

2. We’ve chosen this sample because it evolves harmonically over time and it 
already has a single-cycle loop. Single-cycle loops are perfectly tuned to the 
pitch of the sample. We’re going to duplicate this loop several times, then 
scan through the loops using several kind of modulation sources.
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3. Click the Loop Length Lock button shown below. This handy feature will 
keep the length of our single-cycle loop intact when we move it.

4. Note the start point of the loop (3278 samples). Keep a mental (or written) 
note of this number as we’re going to use it later. 

5. Grab one of the loop handles and drag the loop all the way to the 
beginning of the sample as shown below.

6. From the menu bar select Sample Loop, Duplicate Loop (Ctrl + Shift + D). 
Another loop appears immediately to the right of the first loop.

7. Press Ctrl + Shift + D again. The loop is duplicated again. Repeat this 
procedure until you have 8 loops.
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8. The display should now look exactly like the screen shown below with loop 
number 8 selected (yellow).

9. Remember that number you were supposed to remember? You know, the 
start point of the first loop (3278 samples). Highlight the Start Field and 
type the number 3278. This restores the sustain loop from the original 
sample.

� Connect the Modulation Source
1. Select the Voice Processing page from the Tree.

2. Select All Groups from the Group selector below the envelope display.

3. Patchcord 9 is unused. Program the 
cord as shown at right with LFO 1+ 
patched to Loop Select (Jump) and an 
amount of +100.

4. Select the LFO/LAGS tab and set the Frequency of LFO 1 to about 1.36 Hz.

5. Play the keyboard. You’ll hear the wave being sequenced by the LFO.
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Smooth the Glitches

The wave sequence sounds cool, but you might also be hearing some slight 
glitching caused by the sudden amplitude discontinuities when the waves 
switch. This is a perfect job for a lowpass filter.

6. Select the 4 Pole Lowpass filter. Turn the Frequency wheel down to about 
300 Hz.

7. The Filter Envelope is already connected to the Filter on Patchcord 6. Set 
Cord 6 Amount to about +50.00.

8. Select the FILTER ENV tab. Set the time of Attack 1 to about .3 seconds.

9. Play the keyboard. Now the glitches should have disappeared. As long as 
we’re here go ahead and adjust the filter parameters to your own taste.

Envelope Wave Modulation

10. Next try substituting the Aux Envelope + 
for the LFO by changing the cord source.

11. Select the AUX ENV tab. Adjust the 
envelope parameters until you get an interesting wave sequence going.

12. Try turning Envelope Repeat On. When the envelope repeat function is 
On, the Attack (1&2) and Decay (1&2) stages will continue to repeat as long 
as the key is held.

On Your Own

After you try the Function Generators choose some different waves. We chose 
this particular waveform because it was available to everyone reading this. Truly 
spectacular results can be obtained with waveforms that you sample yourself.

Repeat
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43 Low Frequency Damped Sine Oscillator
OK, we admit it. This programming example 
is completely esoteric and strictly for synth 
nerds. (Whoops, that’s us! Well, maybe you’ll 
like it too.) If you’re feeling adventurous, try 
this technique as it may suggest other ideas 
for cool regenerative patches.

This trick creates a damped sine wave LFO 
using both Lag Processors and six Cords. Any 
sudden change in the control input will make the network “ring” with a 
variable decay time. The patch has a few practical uses as listed below, but more 
importantly it further demonstrates how the Patchcords can be connected to 
create entirely new forms and functions. 

Applications:

� One-shot damped sine for creating “boing” sounds

� “Spring” panning or volume decay

� Pitch or mod wheel that overshoots the mark then settles down.

� Modify LFO waveforms

� Create chaotic or unstable control paths

� To Create a Damped Sine Wave:
1. Open any preset and open the Voice Processing page.

2. Select All Voices in the voice selector.

3. Find five unused Patchcords and program them in the order shown below.

4. Set Lag 1 = 1.00;  Set Lag 2 = 0 

5. Set up the Aux Envelope generator to output a single pulse with a key press 
as shown below. This adds the energy to get the system going.

Damped Sine Wave Patchcords

Source Amount Destination

Aux Env + +100.00 Lag 1 In

Lag 1 +5.00 Pitch

Lag 2 -93.00 Lag 1 In

Lag 1 In +100.00 Lag 2 In

Lag 1 +81.00 Lag 1 In
Emulator X / Proteus X - Advanced Applications Guide 145



Advanced Applications
43   Low Frequency Damped Sine Oscillator
 

6. Play the keyboard. You should be hearing the pitch “boing” when you press 
a key.

� Brain Twister
The block diagram of the patch is shown below. Some of you may recognize 
this as a digital resonant lowpass filter. (Not exactly, because of the low sample rate 
of the control loop, but the concept is the same.) The short pulse from the Aux 
Envelope excites oscillation at the resonant frequency of the filter. The 
Summing nodes are part of the Lag Processors.

The control data through the Lag Processors is calculated once each control 
data loop. We are using this delay in combination with the two feedback paths 
to create the “filter”.

The Lag setting on Lag Processor 1 is used to smooth the waveform. The 
feedback amounts can be used to change the frequency and decay of the sine.

Damped Sine
Patch

Output

Feedback

Feedback

-93%

Lag: 1

Lag: 0

2 sample
delay

1 sample
delay

Delay

(sum)

(sum)

Delay

+100%

Aux
Envelope

(Excitation Pulse)

Lag 1

Lag 2

+81%

Z
-1

Z
-1Σ

Σ
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� More Experiments
After successfully getting the damped sine generator to work, you’ll want to 
start experimenting. Changing the polarity of the Lag 2 output will cause the 
oscillations to become unstable, which can be quite interesting.

Two more possible mods are shown below. These were just discovered by 
experimentation to sound “good”. You’ll undoubtedly find your own gems if 
you poke around in the Patchcords.

Patch Mod #1 Patch Mod #2
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4x Amplifier  99

A
Accents, creating with function generator  49
Acquire, sample  27
Adjust Gain, sample edit  79
ADSR

creating  54
definition  11

AIFF Files, importing  55
Amplifier

background  10
envelope  21

Analog Resampling  125
Arpeggiator, using function generator  46
Audio Editor, external  61
Audition From Disk  134
Auto-loop  33
Automatic Preset Creation  33
Auto-Pan  37

B
Backwards Talking Game  102
Bank, build new  55
Beat

analysis  76
button  77
markers  76
parameters  77
tempo granularity  77

Browsing
presets  52
samples  134

Build Preset Automatically  34
Busses, using multiple VST  112

C
Categories, changing preset & sample  59
Category, changing sample  60
Category, select presets by  52
Center Controls  44, 53
Channel Conservation  58
Chopping Samples  27
Chromatic, sample placement  33
Classic Response  55, 131
Clear Beats  75
Coarse Tuning  99
Continuous Controllers  13
Controllers

knob assignment  15
MIDI setup  14

Controls to Max Shortcut  44
Cord to Pitch Chart  93
Cords, connecting  22
Crossfading Voices  136
Cross-switch Voices  135
Crosswave Synthesis  133
Cubase

assigning multiple busses in  112
creating a drum using  66

Customize a Drum Kit  63
Cycle 2 (Key), explanation  87
Cycle Groups  85

D
Damped LFO  145
DC Offset Example  50
Delay, voice  96
Delete

all loops  75
voice  80

Drag and Drop, samples  86
Dropping Ball Effect  100
Drum Kit, customize  63
Drum Machine, creating a pseudo

using Cubase  66
using Sonar  70

Drum Programming Tip  85
Drums, doubling speed  65
Duplicate Loop  142
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E
Echo

synced to tempo  48
velocity controlled  110

Editing Samples, with other software  61
Effects

creating 3D  130
gating with an envelope  111
using VST  112
voice controlled  110

Envelope
create ADSR type  54
creating unusual  122
gated effects  111
generator, description  11
modulating voice crossfade  136
repeat  136, 144
sustain modulation  123
wave modulation  144

Equalization, of MIDI tracks  116
Exponential Envelope Shapes  122
External Audio Editor  61
External Tempo Source  41

F
Filter

4-pole highpass  137
background  10
effects  91
morph designer  43
pedal control of  40

Filter Override  42
Find Voice  56
Fixed Pitch  99
Floating Keyboard Velocity  55
Footswitch

control of effects  111
latching  121
sostenuto  118

Function Generator
as source for crossfade  138
tricks  54
tutorial  46

G
Gain Wheel, morph designer  43
Gate/Chop Controls  28
Gates

function generator  47
sample aquire, setting  28

Gating Effects  111
General MIDI  64
Generator, envelope  11
Glide

chromatic  97
function generator  49

Glissando  97

H
Horizontal Magnification

region editor  83
sample editor  76

I
Import .wav or .aiff Files  32, 55
Increment/Decrement Presets  52
Insert, VST effects  116
Inspector, Cubase  114
Intelliedit  56, 63

K
Keyboard, placing samples on  18, 31, 134, 140
Key-up Triggering  65
Knob Shortcuts  53
Knobs, connecting  13

L
Label, knob controllers  81
Latching Footswitch  121
Layering, sounds  25
LFO

combining into the quantizer  92
connecting to the filter  22
controlling loop number  143
modulation of crossfading  136

Librarian, using  16, 64, 133, 140
Links  25
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Load
preset  23
samples  16, 85, 133, 140

Logarithmic Envelope Shapes  122
Loop

backward  83
controlling with knob  80
creating multiple  141
direction control  82, 83
envelopes  136, 144
forward  83
number  78
region, creating  81

Loop Length Lock Button  142
Loop Select (Jump)  80
Loop Select Control  42

M
Master Tempo  41
MIDI Connection, for VSTi  114
MIDI Controllers

capture settings  55
connecting knobs to  13

Modulation, pulse-width  126
Morph Designer  43
Multiple Loops  78, 141

controlling  79, 143
Multiple Selection  54
Multiple VST Busses  112
Mute Multiple Voices  54

N
Name

labels for continuous controllers  15
preset  34
sample  127

Natural Sounding Envelopes  55
Natural Sounding Instruments, creating  85
New Preset, creating  79, 81, 86
Note Marker  76

sensitivity  77

O
Octave, repeating  94
Original Key  18, 33, 135

Oscillator, (sample)  10
Output Busses, using multiple VST  112
Output Routing, for quad  131
Outputs Tab  113

P
Panning, quad  130
Pedal

filter  40
volume  38

Phaser  22
Pitch Amount Chart  93
Pitch Detect, sample placement  33
Pitch Wheel

control assignment  14
with twistaloop  84

Place Sample, on keyboard  79, 134
Play from Start Button  78
Poly Key Groups  58
Polyphonic Glissando  97
Preset

building  16
inc/dec  52
jumping to location in the tree  52
locating by category  52
selecting from the tree  52

Preset Effects, voice controlled  110

Q
Q, morph designer  43
Quad Panning  130
Quadrature Sine Wave  130
Quantizer  97

background  93

R
Random Sample & Hold Effect  90
Random Sample Playing  88
Recording, a MIDI track in Cubase  116
Region  29

delete  30
loops  81
naming  30
voice delete  82
voice, setting  82
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Region Xplode  84
Release, effects only during  111
Repeating Envelopes  144
Repeating Octave  94
Resampling  124
Resonant Control Filter  146
Rest, creating with function generator  49
Retrigger Samples, with function generators  50
Reverse, sample edit  78
Reverse, the filter pedal  40
Reversed Keyboard  98
Rotary Knobs, changing the tracking  54

S
Sample & Hold Effects  92
Samples

locating  16, 85, 133, 140
placing on the keyboard  18, 31, 134, 140
replacing on the keyboard  63
selecting multiple  17

Sampling  27
Search Library  16, 64, 133, 140
Sequencer, using function generator as  46
Snap to Marker  76, 82
Solo Multiple Voices  54
Sonar, creating a drum machine using  70
Sort Presets and Samples  60
Sostenuto Pedal  118
Sound Effects

backwards talking  102
boing!  145
dropping ball  118
machine gun drums  105
quad panning  130
random s/h effect  90

Sound Forge, invoking from Emulator X  61
Split Keyboard, creating  25
Stacking, sounds  25
Start At Loop Button  80
Stretch Up & Down, sample placement  34
Subsume Links  26
Summing Nodes  146

T
Templates  35, 45
Tempo Granularity  77
Tempo, changing  41, 83
Tempo, won’t change  48
Toolbars  62
Transpose Voices  136
Tree

jumping to preset in  52
picking samples from the  64
shortcuts  53
type preset names into  53

Tremolo  36
Trigger, function generator  47
Twista Mania Bank, exploring  41
TwistaLoop  75

override  41, 83
synchronizing  84
turning on  83
what does it do?  41

TwistaWave  140

U
Unusual Envelopes, creating  122
Up Layer, double drum speed using  65
Update Library  16, 133, 140

V
Velocity Crossfade  26
Vibrato  36
View Toolbars  62
Voice

delay  96
dropping out, cure for  58
finding keyboard location of a  56
processing, basics  21
stealing, eliminating  58

Voices, rearranging order of  138
VST Busses, assigning to MIDI channels  112
VSTi

connect MIDI to  114
opening Emulator X/Proteus X as  67, 112
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W
Wave (.wav) Samples, importing  32
Wavelab, invoking from Emulator X  61
Weird Voice Effect  102
White Keys, sample placement  33

X
Xplode, region  84
X-wave Synthesis  133

Z
Zero Controls  44
Zoom  76
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